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Take advantage of these resources to develop ArcGIS® software skills, discover applications of
geospatial technology, and tap into the experience and knowledge of the ArcGIS community.

Instructor-led and e-Learning resources

Esri® instructor-led courses and e-Learning resources help you develop and apply ArcGIS skills,
recommended workflows, and best practices. View all training options at esri.com/training/
catalog/search.

Planning for organizations

Esri training consultants partner with organizations to provide course recommendations for job
roles, short-term training plans, and workforce development plans. Contact an Esri training
consultant at training@esri.com.

Esri technical certification

The Esri Technical Certification Program recognizes qualified individuals who are proficient in
best practices for using Esri software. Esri exams are designed to validate expertise with ArcGIS
products, such as ArcGIS Online, ArcGIS Pro and extensions, ArcGIS Enterprise and extensions,
and developer technologies. Certifications are offered at three levels: foundation, associate, and
professional. Learn more at esri.com/training/certification.

Social media and publications

X (formerly Twitter): @EsriTraining and @Esri

Esri on LinkedIn: linkedin.com/company/esri

Esri training blog: esri.com/trainingblog

Esri publications: Access online editions of ArcNews, ArcUser, and ArcWatch at esri.com/esri-
news/publications

Esri training newsletter: Subscribe at go.esri.com/training-news

Other Esri newsletters: Subscribe to industry-specific newsletters at go.esri.com/subscribe

Esri resources
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Esri Press

Esri Press publishes books on the science and technology of GIS in numerous public and private
sectors. esripress.esri.com

GIS bibliography

A comprehensive index of journals, conference proceedings, books, and reports related to GIS,
including references and full-text materials. gis.library.esri.com

ArcGIS documentation and tutorials

In-depth information, tutorials, and documentation for ArcGIS products.

ArcGIS Online: arcgis.com

ArcGIS Desktop: desktop.arcgis.com

ArcGIS Enterprise: enterprise.arcgis.com

ArcGIS Pro: pro.arcgis.com

Esri Community

Join the online community of GIS users and experts. community.esri.com

Esri events

Esri conferences and user group meetings offer a great way to network and learn how to achieve
results with ArcGIS. esri.com/events

Esri videos

View an extensive collection of videos by Esri leaders, event keynote speakers, and product
experts. mediaspace.esri.com

Esri resources (continued)
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ArcGIS for Personal Use

Improve your GIS skills at home and use ArcGIS to enhance your personal projects. The ArcGIS
for Personal Use program includes a 12-month term license for ArcGIS Pro, extension products,
and an ArcGIS Online named user account with 100 service credits. esri.com/personaluse

GIS Dictionary

This term browser defines and describes thousands of GIS terms. support.esri.com/en-us/gis-
dictionary

Esri resources (continued)
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ArcGIS Pro is designed to help GIS professionals complete their projects and make their results
available to others more quickly and easily than ever before. With its modern ribbon interface
and tight integration of 2D and 3D capabilities, ArcGIS Pro can streamline the way you do your
GIS work. This hands-on course will familiarize you with essential ArcGIS Pro terminology and
prepare you to efficiently complete many tasks related to visualization, editing, geoprocessing,
and analysis.

In this course, you will learn how to migrate your work from ArcMap into ArcGIS Pro efficiently
and seamlessly. You can use many items that you originally created in ArcMap without
converting those items. You will see how you can author web maps, web layers, and other items
and then share them on the web.

Course goals

After completing this course, you will be able to perform the following tasks:

• Create an ArcGIS Pro project and import map documents.

• Import other ArcMap resources and identify potential migration issues.

• Create and modify map symbology, text, and layouts.

• Share geospatial resources to an ArcGIS Online organizational site.

Installing the course data

Some exercises in this workbook require data. Depending on the course format, the data is
available on a DVD in the back of a printed workbook or as a data download. To use the data,
extract it to your C:\EsriTraining folder.

Course introduction
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DISCLAIMER: Some courses use sample scripts or applications that are supplied
either on the DVD or on the Internet. These samples are provided "AS IS," without
warranty of any kind, either express or implied, including but not limited to, the
implied warranties of merchantability, fitness for a particular purpose, or
noninfringement. Esri and its authorized distributors shall not be liable for any
damages under any theory of law related to the licensee's use of these samples,
even if Esri and its authorized distributors are advised of the possibility of such
damage.
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Your instructor will provide a temporary account and group to use during class.

Record the information below:

User name: ____________________________________________________________________________

Password: _____________________________________________________________________________

Group name: __________________________________________________________________________

After completing this course, you will need your own account to perform course exercises that
require signing in to ArcGIS Online. The sign-in steps will vary based on your account type.

Training Services account credentials

3



Notes indicate additional information, exceptions, or special circumstances about
specific course topics.

Recommended practices improve efficiency and save time.

Esri Academy resources provide more in-depth training on related topics.

Additional resources provide additional information about related topics.

Warnings indicate potential problems or actions that should be avoided.

Icons used in this workbook
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Your organization may be in the process of migrating from ArcMap to ArcGIS Pro. Learning a
new application requires adjustments, but you will see that ArcGIS Pro is easy to use. While
its functionality is similar to ArcMap, ArcGIS Pro streamlines ArcMap tasks and offers more
capabilities for all facets of desktop mapping. This lesson introduces you to ArcGIS Pro and
how it works within the ArcGIS system.

Topics covered

The role of ArcGIS Pro in the ArcGIS system

Features and characteristics of ArcGIS Pro

Comparing ArcMap and ArcGIS Pro

Basic mapping tasks

1 Getting started with ArcGIS Pro
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ArcGIS is a suite of software and services that help organizations create, manage, share, and
analyze spatial data. The ArcGIS system includes the following parts:

• ArcGIS apps: Programs that most users interact with, including ArcGIS Desktop, mobile

apps, and web applications

• ArcGIS portal: Organizes users with the appropriate content and capabilities based on their

role and privileges; allows administrators, using either ArcGIS Enterprise or ArcGIS Online,

to manage data and resources to integrate with other systems and apps

• Infrastructure: Hardware, software, services, and data components that let users access,

use, and deliver data and capabilities when needed

• External systems and services: Other systems that provide to or consume ArcGIS services

to geospatially enable their capabilities, including Microsoft 365, real-time feeds, and social

media

Figure 1.1. The ArcGIS system is composed of ArcGIS apps including ArcGIS Desktop, the ArcGIS portal,
infrastructure, and external systems and services. These components help to create, manage, share, and analyze
spatial data.

ArcMap and ArcGIS Pro are both desktop mapping applications in the ArcGIS Desktop suite of
applications. Users who worked in ArcMap can migrate to ArcGIS Pro, which has enhanced
functionality that makes creating maps and performing analysis faster and easier. Migration to
ArcGIS Pro is straightforward, and most ArcMap items transfer without issue.

Lesson 1

ArcGIS Pro in the ArcGIS system
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Figure 1.2. ArcGIS Pro, like ArcMap, is a desktop mapping application. ArcGIS Pro seamlessly connects to a
portal, which allows you to easily manage your data.

ArcGIS Pro in the ArcGIS system (continued)

Getting started with ArcGIS Pro
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Work in ArcGIS Pro is organized in projects. A project is a collection of items used for a specific
mapping, spatial analysis, or data maintenance purpose. A project can include the following
components:

• Maps: Maps are used to display layers and analyze data. A map can contain one or more

layers. Each project can contain many maps, and you can display multiple maps

simultaneously.

• Scenes: In ArcGIS Pro, 3D maps are called scenes. Within a project, you can have both 2D

maps and scenes. You can also convert items between 2D maps and 3D scenes.

• Layouts: A layout is a collection of elements organized and designed for map printing.

Common items include a north arrow, a scale bar, and a legend. In ArcGIS Pro, each project

can contain multiple layouts.

• Data and analysis models: You can work with both feature-based and raster-based spatial

data and perform spatial analysis with tools and automation methods.

• Connections to folders, databases, and servers: You can add connections to view, query,

and analyze your data.

Organizing projects in ArcGIS Pro

When you create a project, ArcGIS Pro generates a folder structure containing default project
elements. These items include a home folder, a default geodatabase and toolbox, and default
styles and locators. ArcGIS Pro can also be connected to your active portal.

ArcGIS Pro project files (.aprx) are contained within the project home folder and can contain
more than one map, database, layout, toolbox, and so on. You do not need a different project
for every map or location analysis.

Lesson 1

ArcGIS Pro project structure
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Figure 1.3. ArcGIS Pro organizes your work into projects. A project is a collection of related items—which may
include maps, scenes, layouts, connections, styles, and locators. Each project's home folder contains the project,
a default geodatabase, and a default toolbox.

Best practices for organizing projects

The best practice is to have projects that meet the requirements of the task at hand. You can use
the same ArcGIS Pro project to access all the necessary resources for a project in your
organization, thereby providing efficient management and access.

Whether business, military, nonprofit, or government, organizations might structure their
operations by teams, geographic areas, projects, workflows, customers, or sales regions. ArcGIS
Pro projects can match these structures.

ArcGIS Pro project structure (continued)

Getting started with ArcGIS Pro
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Understanding several basic interface functionalities in ArcGIS Pro will help you navigate the
application. In the following table, ArcMap interface terms are listed next to their respective
ArcGIS Pro equivalents.

FFunctionalityunctionality ArArcMapcMap ArArcGIS PcGIS Prroo

Collection of a table of contents,
toolbars, or attribute tables that can
exist in a floating state or attached to
the main application window

Dockable window Pane

Ways of viewing your data and map Data or layout
view

View

Collection of related software
commands

Toolbar Tab

Collection of vector, raster and
nonspatial data

Data frame Map

Ability to modify layer properties Layer properties
for a given layer
must be opened
to make changes

Context-sensitive: Options in
tabs change based on which
type of layer is selected in
the Contents pane

Layout capabilities One layout in a
map document

Multiple layouts in a project

Lesson 1

ArcGIS Pro interface and structure
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ArcGIS Pro Help: NavigaNavigationtion

ArcGIS Pro interface and structure (continued)

Getting started with ArcGIS Pro
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Imagine that you began working on an analysis of Belize in an ArcMap map document and now
want to import this work into ArcGIS Pro so that you do not have to re-create it from scratch. In
this exercise, you will import a map document of Belize that contains several maps, various
symbology references, and a layout. You will then explore how ArcMap elements fit into the
ArcGIS Pro structure and perform various operations, such as connecting to folders, navigating a
map, and selecting features.

In this exercise, you will perform the following tasks:

• Import a map document into ArcGIS Pro.

• Connect to folders and geodatabases.

• Navigate the map.

• Explore the imported document.

• Select features.

• Save a project.

Exercise 1
Import an ArcMap map document into ArcGIS Pro
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Step 1: Examine the ArcMap map document to be imported

In this step, you will examine a map document that contains several maps, various symbology
references, and a layout. Then, you will import the map document into ArcGIS Pro.

First, you will open the map document in ArcMap to familiarize yourself with its content.

a Start ArcMap.

b From the File menu, choose Open.

c Browse to C:\EsriTraining\PROM\MapDocuments and double-click Import.mxd.

The map document contains three data frames: Belize, New Zealand, and San Juan National
Forest.

d Right-click each data frame in the table of contents and choose Activate to view its contents.

Getting started with ArcGIS Pro
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e Right-click the Belize data frame and choose Activate.

f In the bottom left of the data frame, locate the Layout View button.

g Click the Layout View button.

Even though the map document contains three data frames for three different areas of the
world, the structure of ArcMap allows for only one layout. The two data frames off to the side will
not print in the layout, but you cannot delete them from the layout without deleting them from
the map document.

h From the Customize menu, choose Style Manager.

Lesson 1
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In ArcMap, all styles are loaded and available by default. This map document uses the
Conservation, Environmental, and Transportation styles.

i Close the Style Manager.

j Exit ArcMap without saving.

Step 2: Import a map document into ArcGIS Pro

Next, you will import this map document into ArcGIS Pro.

a Start ArcGIS Pro.

b In the ArcGIS Sign In dialog box, expand ArcGIS Login, if necessary.

c Type the username and password provided by your instructor, and then click Sign In.

d To the right of Recent Projects, click Open Another Project .

e On the left side of the Open Project dialog box, click This PC.

f On the right side of the dialog box, browse to C:\EsriTraining\PROM\Projects\GetStarted,
select GetStarted.aprx, and click OK.

You will now import the Belize map document into the GetStarted project.

g On the Insert tab, in the Project group, click Import Map.

h Browse to ..\EsriTraining\PROM\MapDocuments, select Import.mxd, and click OK.

The imported map document opens in ArcGIS Pro and looks similar to what you saw in ArcMap.

i In the upper-left corner of ArcGIS Pro, locate the Quick Access Toolbar and click the Save
Project button .

Getting started with ArcGIS Pro
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Step 3: Add a folder and geodatabase connection

Before exploring your map, you should connect to frequently used folders and geodatabases. In
this step, you will add a connection to the PROM student data folder and the Belize
geodatabase to allow easy access to your data; these connections do not automatically migrate
during the import process.

a On the right side of ArcGIS Pro, locate the Catalog pane.

The default project structure displays in the Catalog pane. Certain elements, like toolboxes,
databases, and folders, always appear. However, elements such as maps and layouts will only
appear when you add a map or layout to the project. When you create a project, you have
everything that you need to begin working with your data in ArcGIS Pro. Although you may not
use every element for a particular project, the elements are made available for every project.

b In the Catalog pane, expand Folders.

The GetStarted folder is the default project folder and shares the same name as the project.

c Expand the GetStarted project folder.

When you create a project in ArcGIS Pro, a default folder structure is automatically created.
Within GetStarted are several basic project elements, including the project geodatabase and the
project toolbox. The project elements can vary and are empty until you populate them.

You will now add a connection to the PROM student data folder.

d In the Catalog pane, right-click Folders and choose Add Folder Connection.

e In the Add Folder Connection dialog box, browse to ..\EsriTraining, select PROM, and click
OK.

Lesson 1
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The project now has a connection to the project's default folder and a connection to the PROM
folder. Next, you will add a connection to the Belize geodatabase to allow quick access to your
data.

f In the Catalog pane, expand Databases.

g Notice that there is a default project geodatabase named GetStarted.

Every ArcGIS Pro project has a default project database to which geoprocessing output data is
written, unless otherwise specified.

h Right-click Databases and choose Add Database.

i On the left side of the Select Existing Geodatabase dialog box, click Folders.

j On the right side of the dialog box, open the PROM folder, and then open the Belize folder.

k Select Belize.gdb and click OK.

The Belize geodatabase has been added to your Databases folder, where you can quickly
access any data that you might need.

Step 4: Navigate the map

You will now navigate the map that you imported.

ArcGIS Pro combines the functionality of the ArcMap navigation tools into one tool, which is
named the Explore tool. The Explore tool is found on the Map tab in the Navigate group.

a On the Map tab, in the Navigate group, click the Explore tool.

Getting started with ArcGIS Pro
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b Point to the map, and then roll the mouse wheel forward and backward to zoom in and out.

In ArcGIS Pro, navigation tools are found on the Map tab in the Navigate group. As with ArcMap,
in ArcGIS Pro, you can use the Fixed Zoom In and Fixed Zoom Out tools, the Previous Extent or
Next Extent buttons, the Full Extent button, and bookmarks to navigate.

c Experiment with zooming to previous extents, using the fixed zoom buttons, and zooming to
full extent.

In addition, you can save extents in ArcGIS Pro using bookmarks. You will save an extent of all
Belize data and a close-up of Belize features.

d On the left side of ArcGIS Pro, in the Contents pane, right-click Watersheds and choose
Zoom To Layer to view all of Belize.

e On the Map tab, click the Bookmarks button and choose New Bookmark.

f For Name, type Belize Full Extent, and then click OK.

g With the Explore tool active, right-click the map view and choose Magnifier from the
context menu.

The Magnifier tool uses a small overlay window in a 2D map to show a zoomed-in detail of a
location under the window. This overlay window is useful when you do not want to change the
extent of your current view.

h Point to the edge of the overlay window until the outer boundary of the window appears,
and then drag the window over a group of Savanna Ecosystems features that looks
interesting.

i Close the magnifier window by right-clicking the map view and choosing Magnifier
again.

j In the map, zoom to the same group of Savanna Ecosystems features that you viewed in the
magnifier window.

k On the Map tab, click the Bookmarks button and choose New Bookmark.

l For Name, type Belize Close-Up, and then click OK.

m On the Map tab, click the Bookmarks button.
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To facilitate easy navigation of your data, you created two bookmarks: a full extent of all Belize
data and a close-up of Belize features.

n Click the Belize Full Extent bookmark to view all of Belize.

o Click the Bookmarks button again and choose the Belize Close-Up bookmark.

The Explore tool in ArcGIS Pro also provides the functionality of the Identify tool in ArcMap but
with additional capabilities. The Explore tool can move, pan, zoom, and identify feature
attributes through a pop-up. When you click a feature, ArcGIS Pro displays that feature's
attributes in a pop-up. Next, you will view the attributes of a Savanna Ecosystems feature.

p Using the Explore tool, click one of the Savanna Ecosystems features shown in your Belize
Close-Up map extent.

The attributes for the Savanna Ecosystem that you clicked are displayed in a pop-up.

q Close the pop-up.

Step 5: Explore the imported document

In this step, you will explore the elements that were imported from the ArcMap map document
of Belize to this ArcGIS Pro project. First, you will view the layout.
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a In the Catalog pane, expand Layouts and double-click Import to open the layout associated
with the imported map document.

ArcMap elements import into ArcGIS Pro seamlessly, with just a few exceptions. For example, the
title in the ArcMap layout is a dynamic element. The information that the code is looking for is
the title of the map document. This information is not available in ArcGIS Pro, so the element
defaults to the name of the layout. The name of the layout will be the same as the name of the
map document. You will now update the name of the layout, which will also update the title
element in the layout.

b In the Contents pane, double-click the second text entry to open the Element pane on the
right.

To change the title in the layout, you must change the Text property.

c In the Element pane, under Options, expand General.

d For Name, type Layout Title, and then press Enter.
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The updated name of the text element appears in the Contents pane. However, the text in the
layout did not change.

e In the Element pane, under Options, expand Text, if necessary.

f Review the current property tag.

You will notice that the text property is configured with the Name tag. This tag determines how
the element selects the name of the layout as the text to display in the layout.

g Close the Element pane.

h In the Catalog pane, under Layouts, right-click Import and choose Rename.

i Delete the existing text, type Savanna Ecosystems in Belize, and press Enter.

The text in the layout is now updated.

You just saw how layouts migrate when an ArcMap map document is imported into ArcGIS Pro.
The map data frames of Belize, New Zealand, and San Juan National Forest import from ArcMap
to ArcGIS Pro as individual maps in the project.
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j In the Catalog pane, if necessary, expand Maps.

The map document that you imported contains three data frames, which ArcGIS Pro displays as
maps in the project:

• Belize

• New Zealand

• San Juan National Forest

k Right-click the New Zealand and San Juan National Forest maps and choose Open to view
their layers.

The Belize map is already open.

All layers were imported into ArcGIS Pro, so you can continue working on your projects in the
enhanced desktop GIS software.

l Save the project.

Step 6: Select features manually

You will now manually select features in your map.

a Click the Belize map view tab to activate the map.

b In the Contents pane, turn on all layers.

Hint:Hint: Press and hold Ctrl and click the check box next to one of the layer names to turn on all
the layers simultaneously.

c On the Map tab, click the Bookmarks button and choose Belize Full Extent.

The Select tool allows you to manually highlight and choose a subset of features in a map.

d On the Map tab, in the Selection group, click the Select tool .

e Drag a box around all the features of Belize.
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By default, all features are selectable. As in ArcMap, you can choose only specific layers to be
selectable.

f In the Contents pane, click the List By Selection button .

You can view layers based on the number of selected features. You can also make layers
unselectable.

g In the list of selectable layers, uncheck the Roads and Savanna Ecosystems boxes to make
those layers unselectable.
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h On the Map tab, in the Selection group, click the Clear button to clear the selection.

i Drag a selection box that encompasses all features again.

Only features from the Biodiversity Areas and Watersheds layers are now selected.
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j Make Roads and Savanna Ecosystems selectable again and change the Contents pane view
back to List By Drawing Order .

k Clear the selection.

Step 7: Select features by attributes

You now want to select a specific biodiversity area and perform further analysis. You will use the
attributes of the Biodiversity Areas layer to select the Aguacaliente biodiversity area.

a In the Contents pane, right-click Biodiversity Areas and choose Attribute Table.

b Examine the attributes that are available for the Biodiversity Areas layer.

To either float or dock the table in the display, right-click the Biodiversity Areas table
title and click Float or Dock, respectively.

c Close the table.

d On the Map tab, in the Selection group, click Select By Attributes .

e In the Select By Attributes dialog box, for Input Rows, confirm that Biodiversity Areas is
selected.

f For Selection Type, confirm that New Selection is selected.

You will now build an expression. The names of the biodiversity areas are listed under the
attribute KBA_NAME. You will use this attribute to select the specific biodiversity area.

g In the expression builder, next to Where, click the down arrow for Select A Field and choose
KBA_Name.
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h For the second field, the operator, choose Is Equal To, if necessary.

You want to select the Aguacaliente biodiversity area.

i For the final field, click the down arrow and choose Aguacaliente.

j Click Apply, and then click OK.

k In the lower-right corner of the map view, notice the Zoom To Selected Features button .

This button shows the number of selected features. In this case, one feature is selected.

l Click Selected Features: 1.

The map zooms to the selected feature, Aguacaliente.

m Zoom out to see some of the surrounding features.
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Do not clear the selection.

Step 8: Select features by location

Next, you will use spatial relationships to select roads that are within a specified distance of the
selected biodiversity area, Aguacaliente.

a On the Map tab, in the Selection group, click Select By Location .

You will select all roads within 2,000 meters of the selected biodiversity area.

b In the Select By Location dialog box, set the following parameters:

• For Input Features, choose Roads.

• For Relationship, choose Within A Distance.

• For Selecting Features, choose Biodiversity Areas.

• Verify that the Use The Selected Records option is enabled.

• For Search Distance, type 2000 Meters.

c Click OK.
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The roads within 2,000 meters of the Aguacaliente biodiversity area are selected.

d Clear the selection.

e Close the open map views and layout view.

f Save your project and exit ArcGIS Pro.
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1. Which default components are generated when you create an ArcGIS Pro project file?

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

2. How do ArcMap data frames import into ArcGIS Pro?

_______________________________________________________________________________________

Lesson review

Getting started with ArcGIS Pro

1-25





ArcGIS Pro allows you to customize a workspace and control project-level and application-
level settings. ArcGIS Pro offers more configuration options than you might be used to in
ArcMap, including setting the default basemap. In this lesson, you will explore how to
configure a workspace in ArcGIS Pro. You will also learn about ArcGIS Pro custom project
templates and how you can use those templates to create projects.

Topics covered

ArcGIS Pro configuration levels

ArcGIS Pro configuration options

ArcGIS Pro project templates
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When working in ArcGIS Pro, you have the ability to customize configuration options, such as
default unit of measurement and default spatial reference, at the project level or the application
level. These settings can be accessed either from an open project or from the ArcGIS Pro start
page.

Project level

Configuration options at the project level apply only to the project that you have open. If there is
no open project, the options are not enabled.

Application level

Application-level configuration options apply to all projects. Some application options apply
only to new projects, while others apply to the currently open project and to reopened existing
projects.

System administrator settings

These project-level and application-level settings can be controlled through system
administrator configuration settings. ArcGIS Pro allows system administrators to set the default
values for certain settings across a team or organization. These settings can be locked to prevent
users from changing them. System administrator settings are controlled in a file that contains
multiple elements to add application, project, and map and scene settings, among others.

Figure 2.1. ArcGIS Pro contains application and project configuration levels. Optionally, some configuration
settings can be controlled by a system administrator.
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As you have learned, configuration settings are available at both the project and application
levels in ArcGIS Pro. To help streamline your workflows, it is important to know the configuration
options that you can set in ArcGIS Pro.

Application-level options

ArcGIS Pro startup Show the start page, open a project without a template, or open a
specific project

Create a project
folder

Choose whether to organize default project files in their own new
folder

Reset panes Quickly close unnecessary panes while opening predefined
combinations of panes

Define favorites Save a collection of frequently used folders, databases, toolboxes,
servers, custom styles, and other items in a project

Customize Quick
Access toolbar

Add or remove commands from the toolbar above the ribbon for fast
access

ArcGIS Pro configuration options
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Customize ribbon
and tabs

Add new groups and commands to existing tabs or create tabs with
commands

Project-level options

Database
connections

Add a connection, create a file geodatabase, copy or move data between
geodatabases, and set as default

Folder
connections

Add a connection to an existing folder, create subfolders, copy or move
data between geodatabases, and set as default

Alias folder
connections

Use to distinguish folders that have the same name but different paths

Toolbox
connections

Add a connection to an existing toolbox, create a toolbox, create models
and scripts, and set as default
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You can create a customized workspace in ArcGIS Pro by configuring project-level and
application-level options. For example, at the project level, you can create folder or
geodatabase connections to access content. At the application level, you can set up favorites so
that you can access the same content in every project without the need to set up specific
connections each time. You can also customize the ArcGIS Pro ribbon at the application level.

Figure 2.2. Under project and application configuration levels, there are several options to choose from.

Configuring the interface
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Imagine that you are preparing to work on several projects and want to customize your ArcGIS
Pro application. First, you will use an application-level option to change the default basemap
that is used for every new map that is created in a project. Then, you will customize the Quick
Access toolbar and add commands to a custom tab on the ribbon. Finally, you will learn how to
use the pane sets command to return your ArcGIS Pro panes to a useful configuration.

In this exercise, you will perform the following tasks:

• Set a default basemap.

• Customize the toolbar.

• Create a custom tab and add commands.

• Reset panes.

Exercise 2A
Create a customized workspace in ArcGIS Pro
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Step 1: Set a default basemap

In this step, you will customize your ArcGIS Pro workspace to use a default basemap, which is an
application-level setting.

a Start ArcGIS Pro.

b On the start page, at the top left, click Settings.

c On the About ArcGIS Pro page, from the left toolbar, click Options.

d In the Options dialog box, under Application, click Map And Scene.

You may need to scroll down.
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The default basemap of new maps and scenes is the default basemap of your organization. If
you are signed in to ArcGIS Pro, new maps and scenes will use the basemap that was defined for
your organization. You will set your default basemap to Topographic because it allows you to
easily visualize terrain.

e Under Basemap, for Map, click the down arrow and choose Topographic.

f Use the same method to change the default basemap for new scenes to Topographic.

g Click OK.

In this step, you set the default basemap for new projects.

Step 2: Customize the toolbar

Next, you will customize the Quick Access Toolbar, which is an application-level setting. Located
above the ribbon, the Quick Access Toolbar provides easy access to common commands.

First, you will start without a template and add a map.

a On the start page, under New Project, click Start Without A Template.

ArcGIS Pro opens without a template. You can complete your work in ArcGIS Pro with or without
saving the project.
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If you had chosen to start ArcGIS Pro with a template, you would have been prompted
to save the project.

b On the Insert tab, in the Project group, click New Map.

The map opens with the default Topographic basemap.

Next, you will customize the Quick Access Toolbar.

c In the top-left corner of the project, above the ribbon, notice the Quick Access Toolbar.

The Quick Access Toolbar provides access to common commands.

d On the toolbar, click the Customize Quick Access Toolbar down arrow, as shown in the
following graphic.
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On the Customize Quick Access Toolbar menu, you can add commands from a preset list,
remove commands, move the Quick Access Toolbar, minimize the ribbon, and access
customization options.

e From the menu, click Explore.

The Explore button has been added to the Quick Access Toolbar for easy access.

Next, you will use the ribbon to add a tool to the Quick Access Toolbar.

f On the View tab, in the Windows group, locate Pane Sets.

g Right-click Pane Sets.
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h Choose Add To Quick Access Toolbar.

The Pane Sets button now appears on the Quick Access Toolbar.

In this step, you added commands to the Quick Access Toolbar using the Customize Quick
Access Toolbar menu and the ribbon.

Step 3: Create a custom tab

Next, you will create a custom tab, which is an application-level setting.

First, you will add a new tab.

a On the ribbon, click the Project tab.

b On the left-side menu, click Options.

c In the Options dialog box, under Application, click Customize The Ribbon.

You may need to scroll down.
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d In the scrolling window on the right, under Main Tabs, click the New Tab down arrow and
choose New Tab.

In the window, a new tab and a new group are added at the bottom of the list. On the ribbon,
the new tab will appear to the right of the other core tabs by default.

e Click New Tab (Custom) to select it, and then click Rename.

f In the Rename dialog box, for Display Name, type PROM.

g Click OK.

h Under the newly renamed PROM tab, click New Group (Custom) to select it.

i Click Rename and rename the new group Tools.
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j Click OK.

k In the Options dialog box, click OK.

l View the updated ribbon.

In this step, you created a custom tab to use in your project.

Step 4: Add commands to the custom tab

In this step, you will add commands to your new custom tab and group.

First, you will view the new tab.

a On the ribbon, click the PROM tab that you just created.

b Notice that the Tools group is empty.

You will add commands to the group.

c Right-click within the Tools group space and choose Customize The Ribbon.

The Customize The Ribbon section opens in the Options dialog box.

You can also access the Customize The Ribbon section from the Project tab > Options
> Customize The Ribbon.
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d On the right, under Main Tabs, scroll to PROM (Custom).

e Expand PROM (Custom) and select Tools (Custom).

f At the top of the dialog box, under Choose Commands From, select Attribute Table, and
then click the Add button between the two scrolling windows to add the command.

The Attribute Table button has been added to your Tools group.

You will notice that Choose Commands From is set to the Popular Commands menu. You could
change this setting to also access commands from, for example, the All Commands menu or the
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Popular Geoprocessing Tools menu. However, you will continue to add a few more commands
to your group from the Popular Commands menu.

g Use what you learned to add the Clear button and the Rectangle Zoom In button to your
Tools group.

h In the Options dialog box, click OK.

The three commands are added to the Tools group on the PROM custom tab.

In this step, you searched for and added three commands to your custom tab.

Step 5: Reset panes

When working in ArcGIS Pro, you will often want specific panes opened in combination. In this
step, you will explore different ways to reset the panes.

First, you will reset the panes from the ribbon.

a On the ribbon, click the View tab.

b In the Windows group, click Pane Sets and choose Editing.
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The editing panes include the Attributes, Create Features, and Modify Features panes. To the
right of the map, all three panes open and are nested with the Catalog pane.

Next, you will reset the panes for mapping using the command that you added to the Quick
Access Toolbar.

c Above the ribbon, on the Quick Access Toolbar, click the Pane Sets button and choose
Mapping.

The editing panes are now closed and only the Contents and Catalog panes are open.

d Exit ArcGIS Pro without saving any changes.
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In this exercise, you customized your workspace by setting a default basemap, customizing the
Quick Access Toolbar, creating a new tab on the ribbon, and adding commands to the new tab.
You also reset the panes in your project with one click.
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After configuring your workspace in ArcGIS Pro, you can open a project with or without using a
template. You can use one of the provided default templates, or you can create your own
custom project template. You may not need a template if you simply want to visualize and
explore data without saving a project. However, when beginning a project that you intend to
save, project templates are a helpful starting point.

Default templates

Project templates are specific to ArcGIS Pro. Four default templates appear on the start page as
basic starting points for a project:

• Map: Starts a new project with an open map view

• Catalog: Starts a new project with an open catalog view

• Global Scene: Starts a new project with an open global scene view

• Local Scene: Starts a new project with an open local scene view

Figure 2.3. When starting a new project, one of the four default project templates (Map, Catalog, Global Scene,
and Local Scene) can be used as a basic starting point.

Custom templates

A custom project template can be created as a project package that provides either complete
datasets or schema-only definitions based on your unique project needs. Using a custom
project template helps you standardize items that appear in newly created projects, with or
without data. When a new project is started using the custom project template, the new project
will render to exactly match the project that was used to create the custom project template.
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A custom project template can contain several items:

• Maps and scenes

• Connections to folders, databases, and servers

• Complete datasets or schema-only data definitions

• Organizational standard layouts and styles

After a project template is saved, it can be used to create projects that have a consistent
workspace across the organization.

ArcGIS Pro Help: CrCreeaate a prte a project templaoject templatete

Project templates (continued)
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Imagine that you and a coworker are preparing to work on a project about Belize. You and your
coworker will need to look at the same data and have the same data connections but will work in
separate projects. You want to create a project template to share with your coworker to use so
that your projects have the same settings. First, you will add a folder connection, maps, and
layers to create the project template. Then, you will use the project template to set up a new
project. Using a project template will standardize the data and maps so that your coworker can
access the same content and will not have to create the project from scratch.

In this exercise, you will perform the following tasks:

• Add a folder connection for all future projects.

• Add a map.

• Add layers.

• Create a project template.

• Apply the project template.
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Create a project template in ArcGIS Pro
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Step 1: Create a project template with folder connections

In this step, you will create a custom project template with folder connections. Instead of
creating a project, you will start ArcGIS Pro without a template.

a Start ArcGIS Pro.

Although both the Catalog pane and the catalog view let you access all the items associated
with a specific project in one place, the project template with the catalog view should be used if
data management is your primary focus. You will create a project using the Catalog template.

b Under New Project, click Catalog.

c In the New Project dialog box, for Name, type MyProject, if necessary.

d For Location, click the Browse button .

e In the New Project Location dialog box, to the left, click This PC and browse to C:\
EsriTraining, if necessary.

f On the right, open the PROM folder and select the Projects folder.

g Click OK.

h Click OK.
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The project opens to the catalog view, which is the template that you chose. You will connect the
project to the class data folder.

i In the catalog view, right-click Folders and choose Add Folder Connection.

Ensure that you are working in the catalog view in the center of the display and not
in the Catalog pane on the right side of the display.

j Browse to ..\EsriTraining\PROM and click OK.

k In the catalog view, double-click Folders.

By default, folder connections do not persist from project to project. To make a folder connect to
every project that you create, you can set the folder to be added to all new projects.

l In the catalog view, right-click the PROM folder connection and choose Add To New Projects.

This folder connection will now be included in every new project that is created in ArcGIS Pro.
The folder connection will also be added as a favorite. Folder connections can be added to the
Favorites tab without also being added to new projects.

m In the Catalog pane, click the Favorites tab.
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Favorites persist across projects. When accessing folder connections from the Favorites tab, you
can perform all the same functions that you can from a standard folder connection.

Step 2: Add a map

In this step, you will add a map of Belize so that you can add layers to your project. Before you
can add layers, you must first add a map.

a On the catalog view tab, click the to close the view, as indicated in the following graphic.

You will insert a new map from the ribbon.

b On the ribbon, click the Insert tab, if necessary.

c Click New Map.

d In the Catalog pane, click the Project tab and expand Maps.

e Right-click Map and choose Rename.

f Type Belize and press Enter.

Configuring a workspace

2-23



In this step, you added and renamed a new map.

Step 3: Add layers

Next, you will add layers to the map.

You can add data from the Catalog pane or by using the ribbon at the top.

a On the Map tab, in the Layer group, click the Add Data button .

Be sure to click the Add Data button and not the down arrow.

b In the Add Data dialog box, browse to ..\EsriTraining\PROM\Belize and double-click
Belize.gdb to display its contents.

c Select Watersheds_Belize and click OK.

Lesson 2

2-24



Your results may vary, depending on the scale that is set. Additionally, the colors in your results may vary
throughout the course.

The map zooms to Belize and displays the watersheds. In ArcGIS Pro, layers exist in maps, just as
layers exist in data frames in ArcMap.

You will now add layers of protected areas and ecosystems to your map.

d In the Catalog pane, expand Folders.

e Expand PROM, expand Belize, and then expand Belize.gdb.
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f Click ProtectedAreas_2014_Belize, and then press and hold Ctrl and click
SavannaEcosystems_2010_Belize.

g Drag the selected layers into the map.
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The three layers for Belize are displayed in the map using default symbology.

Sharing a project file (APRX) to a coworker is similar to sharing a map document (MXD). Your
coworker would need to have access to the data source for the layers to display in the map. A
custom project template, on the other hand, provides a copy of the data for your coworker to
access.

Step 4: Create a project template

Next, you will save a project template that contains the folder connection and map that you
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added to your project.

a On the Share tab, in the Save As group, click Project Template.

The Create Project Template pane opens.

b In the Create Project Template pane, under Start Creating, select Save Template To File.

c For Name, click the Browse button .

The Share As dialog box opens.

d In the Share As dialog box, browse to ..\EsriTraining\PROM and double-click the Projects
folder.

e For Name, type MyTemplate, and then click Save.

f For Summary, type Project template for class.

g For Tags, type project template, PROM.
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h Click Create.

i If prompted to save the project, click Yes.

j After the project template is created, close the Create Project Template pane.

k Exit ArcGIS Pro without saving.

In this step, you created a project template that will enable your coworker to easily access the
folder connection, data, and map that you added.
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Step 5: Apply the project template

To confirm that all the maps, layers, and folder connections are present, you will now apply the
project template that you created to a new project.

a Start ArcGIS Pro.

b To the right of Recent Templates, click Start With Another Template.

c In the Create New Project From Template dialog box, browse to ..\EsriTraining\PROM\
Projects.

d Select MyTemplate.aptx and click OK.

If you do not see the template file, to the right of the folder path, click the Refresh
button.

e Accept the defaults for the new project name and location and click OK.

f In your new project, use the Catalog pane to verify the presence of the map and the folder
connection.
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g In the Contents pane, verify that your three previously added layers are in the Belize map.

Project templates are a great way to start multiple projects with the same default items. You can
always add items to your project as you work, and you can create multiple project templates.

h Exit ArcGIS Pro without saving.
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1. If you wanted to designate a default unit of measurement in ArcGIS Pro, at which level
would you configure that setting?

_______________________________________________________________________________________

2. In the Catalog pane, is the Favorites tab an application-level configuration or a project-
level configuration?

_______________________________________________________________________________________

3. What can you use to standardize project contents for your organization?

_______________________________________________________________________________________
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Editing is the process of creating and modifying geographic data. This process is more
streamlined and intuitive in ArcGIS Pro than it is in ArcMap. ArcGIS Pro interface tabs contain
all the common editing tools from ArcMap. ArcGIS Pro also provides context menus that you
can access while editing, just like ArcMap does. With the ribbon-based interface, you can
access most functionality from one tab instead of using several editing toolbars. In this
lesson, you will explore the editing environment in ArcGIS Pro.

Topics covered

ArcGIS Pro editing environment

Benefits of editing in ArcGIS Pro

Editing features and attributes in ArcGIS Pro

3 Editing features and attributes
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ArcMap allows you to edit features and attributes using several toolbars, windows, and dialog
boxes. Think about the editing workflow in ArcMap, and then use the workflow graphic to
answer the questions below.

Figure 3.1. The ArcMap editing workflow is the following: start an edit session, choose the workspace and data
frame to edit, use the Editor toolbar and Create Features window, add or modify features, save edits, and stop
the editing session.

1. How many workspaces are you able to edit in an editing session in ArcMap?

_______________________________________________________________________________________

2. What is the first thing you have to do to edit in ArcMap?

_______________________________________________________________________________________

3. Where do you access modification tools in ArcMap?

_______________________________________________________________________________________
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In ArcGIS Pro, editing is an intuitive process, where capabilities and options are grouped
together in one place. Unlike ArcMap, editing functionality can be applied on a layer-by-layer
basis. There are key differences in editing environment functionality between ArcMap and
ArcGIS Pro, as described in the following table.

EditingEditing
envirenvironmentonment
functionalityfunctionality

ArArcMapcMap ArArcGIS PcGIS Prroo

Editing tools Located on the Editor
toolbar

Located on the Edit tab and in the Modify
Features pane

Editing
session

Must manually start and
end edit sessions

Editing session starts automatically when editing
action is performed and ends automatically when
edits are either saved or discarded; you can add a
button on the Edit tab to turn editing on or off

Workspace
editability

Can edit only one
workspace at a time

Can edit multiple workspaces simultaneously; can
be limited to one workspace

Layer
editability

Not available Toggle the layer in the Contents pane

Layer
snapping

Check the layer box in
the Snapping
Environment window

Toggle the layer in the Contents pane

Comparing editing environments in ArcMap and ArcGIS Pro
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As you have seen, editing in ArcMap is similar to editing in ArcGIS Pro; however, editing in
ArcGIS Pro is more streamlined, with editing capabilities and options grouped together in one
place. Think about the workflow in ArcGIS Pro to answer the following questions about the
editing differences between ArcGIS Pro and ArcMap.

What differences in the editing environment in ArcGIS Pro stood out to you?

What are some benefits of editing in ArcGIS Pro?
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When you are editing in ArcMap, the interface tends to get cluttered with numerous toolbars. In
ArcGIS Pro, the same editing options are available in a cleaner environment.

Creating and modifying features

Creating features in ArcGIS Pro is similar to sketching in ArcMap. In ArcGIS Pro, you can turn
snapping and editing functionality on and off by layer. The procedures for modifying vertices
and resizing features are similar in ArcGIS Pro and ArcMap, although the tools are accessed
through one pane in ArcGIS Pro as opposed to multiple toolbars in ArcMap.

Feature templates

All new features are created using a feature template. A feature template is a collection of
default settings for creating a feature, including the attributes of the feature and the default tool
used to create the feature. When you add a feature, these attributes are applied automatically.
You can create more than one feature template for each layer and configure each template with
different attribute values and symbology. For example, you can create several templates that
create building footprints and configure them with a unique attribute symbol that identifies the
building type, such as commercial, residential, or multifamily.

Group feature templates

ArcGIS Pro provides templates called group feature templates. Group feature templates
combine existing feature templates. A group feature template creates multiple features on one
or more layers in a single task-based operation. For example, a water main feature template
might use a group to add a fitting, gate valve, and meter in one action.

Editing in ArcGIS Pro
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Preset templates

In ArcGIS Pro, preset templates create collections of features in repeatable patterns using the
features selected in the current map. For example, you can add a selected cluster of point
features in a fixed arrangement to the map. After clicking the command, you can type the
attribute values that you want to apply to new features and override the geodatabase default
values. By default, the insertion anchor is placed at the geometric center (or centroid) of the
selection set.

Updating attributes

The process for updating attributes is similar in ArcGIS Pro and ArcMap; modifications can be
made directly through the attribute table in ArcGIS Pro, much like in the ArcMap attribute
window. In ArcGIS Pro, attributes can also be updated in the Attributes pane, which has
additional functionality, such as being able to step through the features in an entire feature class.

Table templates

You can also create table templates, which will automatically insert one or more attribute rows
(records) into tables. Table templates can be added to existing feature templates, which will
insert rows into related tables when you create a feature. Table templates can also be used from
the Create Features and Attributes panes.
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Imagine that an owner wants to add a fence around a set of tennis courts. You will locate and
digitize the proposed area to build the new fence. Then, you will modify several features to
match aerial imagery for workers to survey. Finally, you will update attributes to complete the
information on the features.

In this exercise, you will perform the following tasks:

• Set up the editing environment.

• Digitize features.

• Update attributes.

• Modify features.

• Calculate an attribute field.

Exercise 3
Edit features and attributes
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Step 1: Navigate the map using a bookmark

In this step, you will locate the proposed area for the new fence using a bookmark.

a Start ArcGIS Pro.

b Click Open Another Project.

c Browse to ..\EsriTraining\PROM\Projects\CourseProject, select CourseProject.aprx, and click
OK.

The map displays multiple feature layers of the San Juan National Forest.

d On the Map tab, in the Navigate group, click the Bookmarks button and choose Tennis
Courts.
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The map zooms to a recreation court area. You will create a fence around the two tennis courts
on the west side of the facility.

In this step, you located the proposed fence site using a bookmark.

Step 2: Prepare the editing environment

Before you digitize the new fence, you will configure the editing settings.

a On the Edit tab, click Snapping to turn it on.

Your Snapping button should be selected, indicating that snapping is enabled.

b Click the Snapping down arrow.

c Enable Vertex and Edge snapping and ensure that any other snapping options are
disabled.

Editing features and attributes
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Vertex and Edge snapping should be the only enabled snapping options.

You have specified your preferences for snapping. Next, you will prepare to edit features in the
map. By default, an editing session automatically starts in ArcGIS Pro when an editing action is
performed and automatically ends when edits are either saved or discarded. Optionally, you can
modify the ArcGIS Pro settings to add a button that turns editing functions on and off. You will
now add the Edit button to configure this optional functionality.

d On the Edit tab, in the Manage Edits group, click the Editing Options dialog box launcher
.

e In the Options dialog box, click the Editing tab, if necessary, and then, under Set Options For
Editing, expand General.

f Under Productivity, locate the Enable Vertex Editing While Sketching option and uncheck its
box.

Turning this option off will allow you to finish the sketch more easily.

g Expand Session and check the Enable And Disable Editing From The Edit Tab box.

h Click OK.

i On the Edit tab, in the Manage Edits group, click the Edit button to enable editing.

In this step, you enabled the Edit button.

Step 3: Choose a feature template

You will now begin creating the fence feature to add to your feature layer of fences to build.

First, you will choose your feature template and update the template properties.

a On the Edit tab, in the Features group, click the Create button .

The Create Features pane opens and lists the available templates. You can choose a layer, a
subtype, and a construction tool. You can also add feature attributes before creating a feature.
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b In the Create Features pane, under the TemporaryFence layer, right-click the Split Rail
subtype and choose Properties.

c In the Template Properties: Split Rail dialog box, click the Attributes tab.

You will change the value for the fence attribute to tennis courts.

d Next to Fence, click <Null> to clear the text, type Tennis Courts, and press Enter.

e Click OK.

Changes to the template properties allow you to save and use these changes in future project
sessions, like in ArcMap. Because this is a project-level setting, you need to save the project for
the changes to the template properties to persist.

Step 4: Create features by digitizing

A new fence needs to be added to the TemporaryFences feature class. You will use editing tools
to digitize a fence feature using aerial imagery.
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a Zoom to the tennis courts so that you can see the shape clearly.

b On the map, click the top-right corner of the tennis courts, as shown in the following graphic,
to add the start point for the new fence feature.
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A vertex is added as a start point for the fence, based on the point that you added to the map.
Next, you will continue digitizing the fence.

c Click to add vertices to the south of the start point along the tennis courts' edge, as shown in
the following graphic.

d Continue adding vertices around the tennis courts until you reach the corner of your first
point.

e Press F2 or, at the bottom of the map, click the Finish button on the editing toolbar.
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f On the Edit tab, in the Selection group, click the Clear button .
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g On the Edit tab, in the Manage Edits group, click the Save button , and then click Yes to
save all edits.

In this step, you constructed a temporary fence feature using ArcGIS Pro editing tools. You can
now update the attributes of this feature.

Step 5: Update attributes

In this step, you will update other attributes for the fence feature that you just created.

a In the Contents pane, click the List By Selection button .

b In the list of selectable features, confirm that the box for the TemporaryFence layer is
checked.

c On the Edit tab, in the Selection group, click the Select tool .

d In the map, select the fence that you digitized.

You can update attributes from either the attribute table or the Attributes pane. The Attributes
pane is comparable to the Attributes window in ArcMap.

e On the Edit tab, in the Selection group, click the Attributes button to open the Attributes
pane.

You can apply changes as you make them, or you can enable the Auto Apply option to have
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your changes applied automatically.

f At the bottom of the Attributes pane, enable the Auto Apply option.

You already set some attributes before creating the feature:

• In the feature template, you set the FENCE attribute to Tennis Courts.

• You created the new fence using the Split Rail subtype, so the FENCE_MATERIAL field is

set.

g Add the following attributes to the new feature:

• CODE: Recreation

• TYPE: Fence

The Type field uses a domain, which appears as a drop-down list of values.

h On the Edit tab, save all your edits and clear the selection.

In this step, you updated the attributes of the fence feature.

Step 6: Navigate the map using coordinates

Before you modify the lake feature, you will navigate to it using coordinates.

a On the Map tab, in the Navigate group, click the Go To XY button .

b At the bottom of the map view, in the Go To XY window, click the dd down arrow and choose
Degrees Minutes Seconds.

c For Long, type 107 11 46W.

d For Lat, type 37 23 34N.

e Press Enter.

f Zoom out so that you can see the feature.
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In this step, you navigated to the lake feature using coordinates.

Step 7: Verify the accuracy of the feature's shape

Next, you will verify the accuracy of the feature's shape. First, you will change the transparency to
see the imagery underneath.

a In the Contents pane, click the List By Drawing Order button .

b Verify that the Lakes layer is turned on, and then click it to select the layer.

Now that you have selected the Lakes layer, any operations that you perform will affect only that
layer.

c On the ribbon, click the Feature Layer tab.

d In the Effects group, for Transparency, type 75 and press Enter.
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The transparency allows you to see the layers or basemap beneath the Lakes layer.

The lake feature does not quite match the aerial imagery. Parts of the lake feature overextend
the lake's edge, while parts of the lake do not cover the whole lake in the imagery.

Step 8: Modify vertices

Next, you will modify the vertices of the lake to better match the aerial imagery.

a On the Map tab, in the Navigate group, click the Go To XY button to remove the window
at the bottom of the map view.

b In the Contents pane, click the List By Selection button .

c In the list of selectable features, check the Lakes box to make the layer selectable.
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d On the Edit tab, if necessary, click the Select tool .

e On the map, click anywhere inside the lake to select it.

f Zoom to the left side of the lake, where the feature does not cover the lake in aerial imagery.
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You will modify the lake edge to better match the imagery around this area of the lake.

g On the Edit tab, in the Features group, click the Modify button .

h In the Modify Features pane, under Reshape, click Edit Vertices.

i Point to the lake edge and notice that you can modify by dragging either a vertex or an
edge.
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j Drag one edge to the lake edge, as shown in the following graphic.

k Point to a lake vertex and drag it to the lake boundary, as shown in the following graphic.
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l Continue dragging edges and vertices around the rest of this area of the lake.

m After you are finished, press F2 or, at the bottom of the map, click the Finish button .

n Clear the selection.

You will now reshape a portion of the lake.

o Press and hold C on your keyboard (or switch to the Explore tool), and then pan east to the
side of the lake closest to the stream feature.

Just as in ArcMap, pressing and holding the Z, X, or C keys activates the Explore tool,
allowing you to zoom in, zoom out, and pan, respectively, while you create line
segments.
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The imagery reveals that the lake layer is inaccurate here, too, covering features outside the lake.

p On the Edit tab, in the Selection group, click the Select tool .

q On the map, click anywhere inside the lake to select it.

r In the Modify Features pane, click the back arrow, and then click the Reshape tool.

The commonly used Reshape tool allows you to replace larger portions of a geometry than with
the Vertices tool. It requires you to draw a new geometry that crosses or touches the geometry
being modified in two locations. You will use the Reshape tool instead of moving each individual
vertex as before.

s On the map, click a vertex on the top right of the lake edge, where you will begin reshaping.
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t Click to add vertices, from north to south, along the lake edge, as shown in the following
graphic.
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u To create the last vertex, snap to the lake edge on the south side.
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v Press F2 or, at the bottom of the map, click the Finish button .

Alternatively, you can double-click when creating the final vertex to finish reshaping.
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The newly drawn geometry was used to reshape the Lakes layer.

w Save your edits and clear the selection.

In this step, you modified vertices of the lake feature to match aerial imagery.

Step 9: Modify a point feature

Next, you will use the Move tool to modify the location of a fishing site point feature.

First, you will use Select By Attributes to locate the feature.

a On the Map tab, in the Selection group, click Select By Attributes.

The Select By Attributes dialog box opens.

b For Input Rows, choose Recreation Sites.
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c For Where, click the down arrow and choose SITE_NAME.

d Confirm that the second field is set to Is Equal To.

e For the third field, choose LITTLE MOLAS.

Choose the first option for LITTLE MOLAS.

f Click OK.

g In the Contents pane, turn on and select the Recreation Sites layer.

h On the Map tab, in the Selection group, click the Attributes button .

In the Attributes pane, you see that the SITE_TYPE is FISHING SITE.

i In the lower-right corner of the map display, click Selected Features: 1 to zoom to the
recreation site.
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Although it is a fishing site, the recreation site is not located close to the water. You will move this
feature to the lake.

j At the bottom of the pane on the right, click the Modify Features tab to reopen it.

k In the Modify Features pane, click the Back arrow, and then, under Alignment, click Move.

Your selected point turns yellow.

Editing features and attributes

3-29



l Click the point and drag it to the center of the lake.

m Press F2 or, at the bottom of the map, click the Finish button .

Lesson 3

3-30



n Save all your edits and clear the selection.

In this step, you used the Move tool to move a fishing site to a different location.

Step 10: Calculate an attribute field

You want to update an attribute field that is empty in the Lakes feature layer. In this step, you will
use the Calculate Field tool to update the LAKE_TYPE attribute.

a In the Contents pane, click the List By Drawing Order button , if necessary.

b Right-click Lakes and choose Attribute Table.

Editing a single attribute is manageable. But sometimes you need to update an attribute for
many features at the same time, which can be tedious and lead to potential errors. The Calculate
Field tool is the best option for updating the same attribute for multiple features.

c In the attribute table, right-click the LAKE_TYPE field and choose Calculate Field.

d In the Calculate Field dialog box, in the field for LAKE_TYPE = , type "Public""Public", as shown in
the following graphic.
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e Click OK.

In the attribute table, the LAKE_TYPE field is set to Public. You have updated all features at the
same time using Calculate Field.

f Save all your edits.

g Close the attribute table.

h Close any open map views.

i On the View tab, in the Windows group, click the Pane Sets button and choose Mapping.

The Pane Sets button quickly opens the panes that support a common workflow, such
as mapping, editing, or geoprocessing, and closes any other open panes.

j Save your project and exit ArcGIS Pro.
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1. How do you start and stop an edit session in ArcGIS Pro?

_______________________________________________________________________________________

_______________________________________________________________________________________

2. In ArcMap, you must start and stop edit sessions, and you edit one workspace at a time.
How is this process different in ArcGIS Pro?

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

Lesson review
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Workflow review (page 3-2)

1.1. How many workHow many workspaces arspaces are you able to edit in an editing session in Are you able to edit in an editing session in ArcMap?cMap?

One workspace

2.2. WhaWhat is the first thing you have to do to edit in Art is the first thing you have to do to edit in ArcMap?cMap?

Start an edit session

3.3. WherWhere do you access modificae do you access modification tools in Artion tools in ArcMap?cMap?

From several toolbars

Answers to lesson 3 questions
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Symbolizing GIS data is vital to map readability and communication with the map audience.
ArcGIS Pro contains tools to change colors, change classification schemes, and symbolize
data based on attribute categories. In this lesson, you will learn about symbolizing data
using different methodologies, as well as about adding and importing styles. You will also
learn how to set layer display properties, control the visibility of layers using scale ranges,
and control symbol sizes using scale-based symbols.

Topics covered

Symbolizing features

Importing and adding styles

Setting scale ranges for layers

4 Symbolizing data
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ArcMap offers many methods for symbolizing your data based on attributes. Consider some of
the symbology options that you have used in ArcMap, and then answer the following question.

What are some of the symbology options in ArcMap?
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The symbology options in ArcGIS Pro and ArcMap are similar. However, accessing symbology is
different in ArcGIS Pro because the interface is context-sensitive. After you select the layer that
you want to symbolize, only symbology options that are applicable for the selected layer are
made available. The following table lists symbology options and descriptions.

SSymbologyymbology
optionoption

ExampleExample FFeeaaturturee
typetype

DescriptionDescription

Single
symbol

Points,
lines,
polygons

Default symbology for added layers; displays quickly
but is not descriptive.

Unique
values

Points,
lines,
polygons

Categorical symbology option for qualitative data,
such as names and descriptions; features are
assigned unique symbols based on an attribute.

Graduated
colors

Points,
lines,
polygons

Quantitative symbology option where, typically, a
lighter shade of a color represents a lower numeric
value and a darker shade of the same color
represents a higher numeric value.

Symbolizing layers in ArcGIS Pro
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SSymbologyymbology
optionoption

ExampleExample FFeeaaturturee
typetype

DescriptionDescription

Bivariate
colors

Points,
lines,
polygons

Quantitative symbology option that shows the
relationship between two variables in a feature layer.
Each variable is represented by a graduated color
scheme that is blended so that the values can be
visually compared, emphasized, or delineated.

Graduated
symbols

Points,
lines,
polygons

Quantitative symbology option where symbol size
reflects a range of attribute values; smaller symbols
typically represent lower values, and larger symbols
typically represent larger values. Features are
grouped into classes.

Proportional
symbols

Points,
lines,
polygons

Quantitative values represented as a series of
unclassed symbols, sized according to each specific
value.

Heat map Points Draws point features as a representative surface of
relative density; used when many points are close
together and cannot be easily distinguished; can
also represent the density of points weighted by an
attribute.
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SSymbologyymbology
optionoption

ExampleExample FFeeaaturturee
typetype

DescriptionDescription

Dot density Polygons Quantitative values for one or more fields
represented as a collection of point symbols
(typically solid circles or dots) within each polygon.
Each dot represents a number of things.

Unclassed
colors

Points,
lines,
polygons

Shows qualitative differences in feature values with a
range of colors not broken into discrete classes;
similar to graduated colors.

Chart Points,
lines,
polygons

Each part of a chart represents an attribute value to
communicate quantitative differences between
attributes.

Aggregation Points Aggregating features is a way to summarize them
into logical groups using statistical methods. Two
ways aggregation can be done are clustering or
binning.

Symbolizing layers in ArcGIS Pro (continued)
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When you used symbols and styles in ArcMap, the styles were loaded by default. In ArcGIS Pro,
you can import styles from ArcMap, import a custom style, or add styles from ArcGIS Online.
ArcGIS Pro does not include all available styles in the installation, which saves disk space and
eliminates the need to browse through dozens of styles that you do not use. To import styles or
add styles to your project in ArcGIS Pro, you must perform one of the following steps:

• Import a style that is stored locally on your system. This method works for styles that were

part of the ArcMap installation on your machine and for custom styles that you created in

ArcMap.

• Add a custom style or create styles in ArcGIS Pro.

• Add a style from ArcGIS Online or ArcGIS Enterprise.

You can add different types of styles to your map, scene, or layout, including ArcGIS Pro styles,
ArcGIS Desktop styles, custom styles, and favorites styles.

Figure 4.1. Multiple types of styles are available for you to use in ArcGIS Pro, depending on your needs: ArcGIS
Pro styles, ArcGIS Desktop styles, custom styles, and favorites styles.

• ArcGIS Pro styles: Styles that are authored by Esri and included in the ArcGIS Pro

Lesson 4
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installation

• ArcGIS Desktop styles: Styles that are created in and used in ArcMap, ArcScene, and

ArcGlobe

• Custom styles: Styles that are created in both ArcMap and ArcGIS Pro and that can be

added like ArcGIS Desktop styles

• Favorites styles: Styles that are always available in a project and appear at the top of

galleries

In ArcGIS Pro, style files can include more than just symbology. You can save all the
style items like symbols, colors, label placements, and layout items used in any map,
scene, layout, or other project item and have them accessible in one style. The style
items are categorized by their associated project item, such as a layer or layout. For
more information, go to ArcGIS Pro Help: Manage styles.

ArcGIS Pro Help: SStylestyles

ArcGIS Pro Help: Add styles to a prAdd styles to a projectoject

Sources of symbology styles (continued)
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Imagine that you are creating an environmental map of Belize for an organization to use. You are
migrating to ArcGIS Pro and want to symbolize layers in the same way that you used to in
ArcMap. You will import and add the environmental styles that you used in ArcMap and then
symbolize layers using methods to better represent your features.

In this exercise, you will perform the following tasks:

• Import and apply styles.

• Change layer display properties.

• Symbolize using different methods.

• Change data classification properties.

• Set scale ranges for layers.

Exercise 4
Modify symbology and the display of layers
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Step 1: Create a project using a template

You will create a project using the Belize template that you previously created. Then, you will
rename the layers so that the data is easier to interpret.

a Start ArcGIS Pro.

b On the right, under Recent Templates, click MyTemplate.

The instructions in this box are only necessary if you did not already complete the
previous workflow to create MyTemplate. If you are unsure, ask your instructor for
assistance.

1. Start ArcGIS Pro and click Start With Another Template.

2. In the Create New Project From Template dialog box, browse to ..\

EsriTraining\PROM\Results\Exercise02B.

3. Select MyTemplate.aptx and click OK.

c For Name, type BelizeProject.

d For Location, browse to ..\EsriTraining\PROM\Belize.

e Click OK.
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Your Belize map shows three layers.

1. How are ArcMap and ArcGIS Pro the same regarding default layer symbology?

___________________________________________________________________________________

f In the Contents pane, change the name of the map to Belize Symbology.

g Change the name of the Watersheds_Belize layer to Watersheds.

h Change the name of the ProtectedAreas_2014_Belize layer to Protected Areas.

i Change the name of the SavannaEcosystems_2010_Belize layer to Savanna Ecosystems.

j Save your project.

Step 2: Import styles

In this step, you will import ArcMap styles into your project that better represent your
environmental data.

First, you will view style properties using the catalog view.

a On the View tab, in the Windows group, click the Catalog View button .

A catalog view is added to the display.

b In the catalog view, double-click Styles.

c Under Name, click any of the styles listed.
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In the catalog view, you can manage each style, see the items in each style class, and view the
description and graphical properties of each style item.

Next, you will use the Catalog pane to import styles.

d Close the catalog view.

e In the Catalog pane, expand Styles.

The default styles for the project are listed, but there are no industry-specific styles, such as the
Transportation, Forestry, or other styles found in ArcMap. If you want to use ArcMap styles, the
best way is to import them.

ArcMap and ArcGIS Pro style files have different file name extensions; when you
import a style from ArcMap, it is converted to an ArcGIS Pro style (.stylx).

You will import the ArcMap Conservation and Environmental styles.

f In the Catalog pane, right-click the Styles folder, point to Import and choose Import.

g In the Import Style dialog box, browse to C:\Program Files (x86)\ArcGIS\Desktop10.8 and
double-click Styles.

h Scroll down and click Conservation, and then press Ctrl and click Environmental.

i Click OK.

j In the Catalog pane, expand the Styles folder.
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The imported styles are now part of your project.

To download styles from ArcGIS Online, in the Catalog pane, click the Portal tab, and
then click the ArcGIS Online button . Include stylx in the search terms to find only
ArcGIS Pro style files, which use .stylx as the file name extension (for example,
Conservation_en.stylx).

To make it easier to import styles into future projects, you will add the ArcMap styles to your
favorites.

k In the Catalog pane, click the Favorites tab.

l Under Favorites, click Add Item and choose Add Folder.

m In the Add Folder Connection dialog box, browse to C:\Program Files (x86)\ArcGIS\
Desktop10.8\Styles and click OK.

n Save the project.

In this step, you imported ArcMap styles into your project and added the ArcMap styles to the
Favorites tab for easy access.

Step 3: Apply styles

In this step, you will symbolize your Watersheds layer using the styles that you just imported.

a In the Contents pane, for the Watersheds layer, right-click the symbol to open the color
palette, and then, under Conservation, choose the second blue symbol (Marine Ecoregions),
as indicated in the following graphic.
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You added the Conservation style to your project, so it is available from the color
palette.

Although the fill color can be updated by right-clicking the symbol in the Contents pane, the
outline color must be set in the Symbology pane.

b In the Contents pane, click the symbol for Watersheds.

The layers are context-sensitive, so the Symbology pane is specific to the Watersheds layer.

c In the Symbology pane, click the Properties tab.

d Under Appearance, for Outline Color, in the Conservation group, choose the white color
(Marker Background).

e Click Apply, and then close the Symbology pane.

f Zoom and pan the map to see how quickly the display updates.

As you zoom and pan your map, navigation in ArcGIS Pro happens quickly. Like ArcMap, ArcGIS
Pro has basemap layers that you can create and add layers to. The extents are then cached to
improve display and drawing time.

g In the Contents pane, right-click Watersheds and choose Zoom To Layer.

Step 4: Change layer display properties

Next, you will adjust the layer display properties to control how the layers appear.

a In the Contents pane, turn off the Savanna Ecosystems and the Protected Areas layers.

b In the Contents pane, verify that the Watersheds layer is selected.

c Click the Feature Layer tab.

The Feature Layer tab contains tools for changing how layers appear. The tab includes the
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following groups, among others:

• Visibility Range (to set the minimum and maximum scales at which the layer will display)

• Effects (including transparency and blending)

• Compare (including the Swipe and Flicker tools)

• Drawing (including symbology and masking)

2. What step do you need to perform before changing a layer's display properties?

___________________________________________________________________________________

Now that you have selected the Watersheds layer, any operations that you perform will affect
only that layer. You will use the Transparency, Swipe, and Flicker tools.

d In the Effects group, set Transparency to 50, and then press Enter.

e In the Contents pane, turn on the Protected Areas layer.

f Select the Protected Areas layer.
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g On the Feature Layer tab, in the Compare group, click the Swipe button .

In the map, your cursor changes to an arrow that points up, down, left, and right.

h In the map, click and hold and then drag across to the left or right or up and down to swipe
the Protected Areas layer.

You used the Swipe tool to see the Watersheds layer beneath the Protected Areas layer. Swipe is
a great way to see other layers without turning the layers on and off in the Contents pane.

i On the Feature Layer tab, click the Flicker button to automatically switch the Protected
Areas layer off and on at a set time interval.

j Click the Flicker button again to turn it off.

k In the map view, right-click and choose Exit Swipe Mode.

You used the Flicker tool to see the Watersheds layer beneath the Protected Areas layer at a
timed interval. Flicker is useful for temporal change detection, data-quality comparison, and
other analyses for which you want to visualize differences between layers.

Step 5: Symbolize using unique values

In the next few steps, you will symbolize road vector data to emphasize certain attributes and
show important information about your features using unique values.

a In the Catalog pane, click the Project tab, expand Folders, and then expand PROM.

b Expand the Belize folder, expand Belize.gdb, and add Roads_2013_Belize to the map.

c Change the layer's name to Roads.

d In the Contents pane, ensure that Roads is selected.

e On the Feature Layer tab, in the Drawing group, click the Symbology down arrow and
choose Unique Values.

The Symbology pane opens.

f In the Symbology pane, for Field 1, choose Road_Type.

g Click the Color Scheme down arrow and check the Show Names box.
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Checking the Show Names box will display the names of the available color schemes to make
them easier to find.

h Choose the Basic Random color scheme.

i Below the color scheme, on the Classes tab, click More and choose Format All Symbols, as
shown in the following graphic.

j At the bottom of the pane, turn on the Auto Apply option.

By turning on the Auto Apply option, any symbol edits that you make will automatically update
in the map layer. Depending on your workflow, you can decide whether enabling Auto Apply is
the best choice for your project. Because your workflow uses simple symbol editing, enabling
Auto Apply is a good option.

k On the Properties tab, set Line Width to 2 Pt.

l Zoom in on some roads to see how the features are symbolized.
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Throughout this exercise, the symbology colors might be different in your results.

m Zoom to the extent of the Roads layer.

n Save the project.

In this step, you symbolized the Roads layer using unique values.

Step 6: Symbolize using graduated colors

Next, you will symbolize the Protected Areas quantitative data using the Acres field and
graduated colors.

a In the Contents pane, turn off the Watersheds, Savanna Ecosystems, and Roads layers.

b Verify that the Protected Areas layer is turned on, and then open its attribute table.
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When you set the symbology properties for Protected Areas, you will use the ACRES field as the
numeric attribute.

c Close the attribute table.

d In the Contents pane, verify that Protected Areas is selected.

e In the Symbology pane, change Primary Symbology to Graduated Colors.

Because ACRES is the first numeric field in the Protected Areas table, that field is selected as the
value field. The default classification method is Natural Breaks (Jenks), and the default number
of classes is 5.

In this step, you symbolized the Protected Areas layer using graduated colors.
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Step 7: Change classification properties

Next, you will alter the number of classes, classification method, and color scheme to better
represent the Protected Areas data.

a In the Symbology pane, for Classes, choose 3.

With three classes, you can easily differentiate the colors in both the map and the legend. Next,
you will change the classification method.

b In the Symbology pane, for Method, choose Quantile to display the same number of features
in each class.

The classification methods in ArcGIS Pro are the same as the classification methods in
ArcMap.
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c Experiment with some other classification methods and observe how each method affects
the way in which the data displays.

3. How does changing the classification method affect the data display?

___________________________________________________________________________________

___________________________________________________________________________________

4. Why would you classify this layer using Natural Breaks rather than Quantile?

___________________________________________________________________________________

___________________________________________________________________________________

___________________________________________________________________________________

d Set Method back to Natural Breaks (Jenks) and Classes back to 3, if necessary.

ArcGIS Pro has color schemes to match the number of classes that you specify. For example, you
can use green, blue, red, gray, purple, or orange for three or more classes (up to nine) as well as
a continuous color scheme for each color.

e Click the current color scheme, check the Show Names box if necessary, and choose Greens
(3 Classes).
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You can quickly assign a color scheme based on the number of classes.

f Save the project.

Step 8: Symbolize a point layer

Next, you will add the Towns point layer to BelizeProject and symbolize the layer.

a From the Catalog pane, drag the Towns_2010_Belize layer into the map.

b Rename the layer Towns.

c At the bottom of the Catalog pane, click the Symbology tab.

Notice that the Symbology pane now references the new Towns layer because it is the selected
layer.
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d Symbolize the towns with Graduated Symbols using the POPULATION field and 5 classes.

e In the Symbology pane, next to Template, click the circle symbol.

The Format Point Symbol - Template pane opens.

f Click the Properties tab, if necessary.

g Under Appearance, for Color, in the Environmental group, choose the light gray color (Test
/Sample, Sediment).

The symbology updates automatically.

h Using the Explore tool, zoom in toward one of the towns.

You will notice the varying sizes of the symbols, which are based on the five population value
classes.

i In the Contents pane, view the legend to compare the symbol sizes with the values.

j Zoom to the extent of the Towns layer.
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You symbolized a point layer using graduated symbols.

k Save the project.

Step 9: Set scale ranges for layers

Next, you will set a custom scale range for the Towns layer.

a Verify that the Towns layer is selected and, on the Feature Layer tab, in the Visibility Range
group, click the Minimum Scale down arrow.

Like in ArcMap, you can manually enter a new scale to set a scale range and can also customize
the scale list.

b Choose Customize.

The Scale Properties pane opens. A list of the standard scales is shown. You will add a custom
scale.

c Above the heading for Scale, type 750000.

d Click Add, and then click OK.

The list will now include 1:750,000 as a choice for scale range.

e Click the Minimum Scale down arrow and choose 1:750,000.

The Towns layer will no longer appear at scales smaller than 1:750,000.

f If necessary, zoom out beyond 1:750,000 so that the town features disappear.
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g Zoom in so that the scale is greater than 1:750,000 and the town features appear.

h Turn off the Towns layer.

In this step, you set scale ranges for a layer based on a custom scale range.

i Save your project and exit ArcGIS Pro.
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1. Explain the similarities and differences between symbolizing features in ArcMap and
symbolizing features in ArcGIS Pro.

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

2. How do you import a style file from ArcMap into ArcGIS Pro?

_______________________________________________________________________________________

_______________________________________________________________________________________
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Symbology review (page 4-2)

WhaWhat art are some of the symbology options in Are some of the symbology options in ArcMap?cMap?
Possible responses include the following approaches:

• Symbolizing based on an attribute (qualitative) or symbolizing based on a number
(quantitative)

• Classification methods, including natural breaks, quantile, equal interval, manual
interval, and standard deviation

• Graduated colors and graduated symbols
• Color, size, and shape

Exercise 4: Modify symbology and the display of layers (page 4-8)

1.1. How arHow are Are ArcMap and ArcMap and ArcGIS PcGIS Prro the same ro the same regaregarding default layer symbology?ding default layer symbology?

Both applications use random single symbol colors.

2.2. WhaWhat step do you need to perform befort step do you need to perform before changing a layer's display pre changing a layer's display properoperties?ties?

Select the layer in the Contents pane.

3.3. How does changing the classificaHow does changing the classification method affect the dation method affect the data display?ta display?

The method determines how many features are in each class, which affects the

interpretation of the data.

4.4. Why would you classify this layer using NaWhy would you classify this layer using Naturtural Bral Breeakaks rs raather than Quantile?ther than Quantile?

To show a more even distribution of acreage in the protected areas, you would use

Quantile. To highlight the expanse of high-acreage protected areas, you would use

Natural Breaks.
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Adding text to a map can enhance the map's appearance and highlight key information.
Placing text on a map serves many purposes, such as identifying geographic features or
geographic areas, like mountain ranges. ArcGIS Pro has several text options, including
annotation, graphic text, and labels, that you can apply to your maps to make them more
meaningful. In this lesson, you will learn about these text options, as well as how to set scale
ranges and create label classes.

Topics covered

Labeling features

Setting scale ranges

Creating label classes

5 Adding text to a map
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ArcMap offers many methods for adding text to a map. Think about your use of map text in
ArcMap, and then answer the following question.

Which methods does ArcMap offer for adding text to a map?

Lesson 5
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Text can enhance a map's appearance and highlight important information. ArcGIS Pro provides
three options for adding text to a map: labels, annotation, and graphic text.

The following table summarizes each text option.

TType of map teype of map textxt ScaleScale SStortorageage ModificaModificationstions

Labels Dynamic
(redraw to
map scale)

Properties of a
layer

Cannot be individually
manipulated

Annotation
(standard or
feature-linked)

Reference
scale is set

As a geodatabase
annotation feature
class

Can be edited; edits will be
reflected anywhere the annotation
layer appears

Graphic text Reference
scale is set

In a map in an
ArcGIS Pro project

Can be modified

Labels

A label is any dynamically placed text that identifies one or more feature attributes on a map.
Labeling is used to quickly add text to your map without having to manipulate each feature
individually. Labels are useful if you are creating maps at different scales or if your data changes.
In ArcMap, labels can be added and managed using both the Standard Label Engine and the
Maplex Label Engine, with the default being the Standard Label Engine. ArcGIS Pro can also use
both the Standard and Maplex labeling engines, but the default is the Maplex Label Engine. The
Maplex Label Engine provides label placement options and functionality that are not available
with the Standard Label Engine. With the Maplex Label Engine in ArcGIS Pro, you can orient and
place labels, determine how labels fit in congested areas, determine how label conflicts are
resolved, and use scale-based label sizing to adjust the size of text symbols used for labeling
dynamically across their visible scale range.

Adding text using ArcGIS Pro
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Annotation

To enable editing of your text, labels can be converted to annotation. Annotation is similar to
labeling, but annotation provides more flexibility over the appearance and placement of your
text because individual pieces of text can be edited. In ArcGIS Pro, you can convert existing
labels into annotation or create annotation features manually. Just like in ArcMap, you can create
either standard annotation or feature-linked annotation. Standard annotation is not linked to any
other features, so the text added to a map stands alone. Feature-linked annotation creates a
relationship between a feature and the annotation associated with that feature. Feature-linked
annotation ensures that, when you delete a feature, the associated annotation is also deleted.
With either annotation method, the reference scale will be set from the map scale and the
annotation will be the same size and position as the labels that you converted.

Graphic text

Graphic text allows you to annotate your map without a geodatabase—the graphic text is stored
in your project as a graphics layer in the map. You can use graphic text to make simple
notations. Graphic text does not need to be linked to any feature and its reference scale will be
set to the map scale. Map annotation and Draw toolbar graphics from ArcMap are
interchangeable with graphic text in ArcGIS Pro and are imported into ArcGIS Pro as graphic
text.
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When labeling your features in ArcGIS Pro, you may have specific groups of features that use the
same text size, symbol, or scale range. Label classes can be used to set labeling properties for
only those certain features. Label classes could be used to differentiate road types from the
same road layer, like highways, state roads, and local roads.

Label classes can be based on an attribute field or a query. Label classes can be changed
individually, or you can select multiple classes at one time to change the labeling properties for
all label classes. You can also copy and paste labeling properties between label classes,
duplicate label classes, and reorder label classes.

Figure 5.1. In this example, only the default label class is being used for the roads layer in the image on the left.
All roads have the same font size and color. In the image on the right, multiple label classes have been applied;
the local, secondary, and primary roads have different font sizes and colors, with the most importance placed on
primary roads.

Label classes
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Although you can add text to maps in ArcMap and ArcGIS Pro in similar ways, there are some
differences in how these capabilities are accessed. For example, ArcGIS Pro does not support
map annotation, but you can use graphic text to achieve the same result.

The following list describes the three labeling options and how the options in ArcMap relate to
the options in ArcGIS Pro:

1. Automatically generated and dynamically placed text for features on a map

• ArcMap: Labels accessed through the Label Manager or layer properties

• ArcGIS Pro: Labels accessed from the Labeling tab, List By Labeling in the Contents

pane, and the Label Class pane

2. Annotation pieces that store their own position, text string, and display properties

• ArcMap: Geodatabase annotation feature class (standard or feature-linked)

• ArcGIS Pro: Geodatabase annotation (standard or feature-linked)

3. Text elements stored in a geographic space without creating features

• ArcMap: Map annotation and Draw toolbar graphics

• ArcGIS Pro: Graphic text

Lesson 5
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You will continue working on your project for Belize and set labeling properties in preparation
for labeling environmental features in ArcGIS Pro. After labeling environmental features, you will
label roads, some of which will need to be managed individually and converted to annotations.
You will convert labels to standard annotation so that you can manage the text individually.

In this exercise, you will perform the following tasks:

• Set basic labeling properties.

• Modify labels.

• Set scale ranges for labels.

• Create label classes.

• View the labeling summary.

• Convert labels to annotation.

• Edit annotation.

Exercise 5
Label features
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Step 1: Set basic labeling properties

In this step, you will work with labeling properties to see labels and their corresponding
features.

First, you will open your BelizeProject and label features.

a Start ArcGIS Pro and open BelizeProject.

The instructions in this box are only necessary if you did not already complete the
previous workflow to create BelizeProject and the Belize Symbology map. If you are
unsure, ask your instructor for assistance.

1. Start ArcGIS Pro.

2. Click Open Another Project.

3. Browse to ..\EsriTraining\PROM\Results\Exercise04\BelizeProject and open

BelizeProject.aprx.

b View the Belize Symbology map.

c On the Map tab, in the Layer group, change the basemap to Light Gray Canvas.

d In the Contents pane, turn off visibility for the Light Gray Reference layer.

e Zoom to the extent of the Protected Areas layer.

f Make Protected Areas and Light Gray Base the only visible layers, if necessary.

g In the Contents pane, select Protected Areas, if necessary.

h Click the Labeling tab.

From the Labeling tab, you can manage label classes, change label fonts, set label scale ranges,
and handle label placement.

Next, you will label the Protected Areas layer.
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i On the left, in the Layer group, click the Label button to turn on the labels.

With the display zoomed out, it is difficult to see all the labels and their corresponding features.

j With the Explore tool, zoom in to the northernmost area of the features.
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When you change the map perspective, the label display changes. Labels in ArcGIS Pro appear
dynamically, the way they do in ArcMap.

Step 2: Modify labels

You will now change the label font.

a On the Labeling tab, in the Text Symbol group, click the down arrow, as shown in the
following graphic.

You can choose from presets in the gallery or modify the labels on your own.

b Close the gallery.

c On the Labeling tab, in the Text Symbol group, change Text Symbol Font from Tahoma to
Corbel.
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Your text font has been updated.

Several labels are duplicated in the map. You will remove the duplicates.

d On the Labeling tab, in the Label Placement group, click the Label Placement Properties
button, as shown in the following graphic.

e In the Label Class pane, click the Position tab, and then click the Conflict Resolution button
.

f If necessary, expand Remove Duplicate Labels, and then click the down arrow and choose
Remove All.

Duplicate labels have been removed from your map.
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Step 3: Set scale ranges for labels

Next, you will set a scale range on the labels for the Protected Areas layer so that you only see
certain labels at certain scales.

a Zoom to the extent of the Protected Areas layer.

When you zoom to the extent of the Protected Areas layer, the labels are cluttered—many of the
labels overlap and are hard to see. Scale ranges on labels will reduce map clutter at smaller
scales and make the map easier to understand.

b In the Contents pane, verify that Protected Areas is selected.

c On the Labeling tab, in the Visibility Range group, click the Minimum Scale down arrow and
choose 1:500,000.
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The labels do not appear when zoomed to the extent of the layer.

d Zoom in beyond 1:500,000 to display the labels.

Your labels reappear when zoomed in beyond 1:500,000. You have set scale ranges for labels
using a visibility range.

Step 4: Create label classes

Earlier, you symbolized the Roads layer based on the type of road. Now, you will create label
classes using the same information so that each type of road has its own label style.

a In the Contents pane, turn off Protected Areas.

b Turn on the Roads layer and select it.

You can use label classes to restrict labels to certain features or to specify different label
placement properties for different groups of features. You will now use label classes to restrict
labels to the distribution roads and feeder roads.

c On the Labeling tab, in the Label Class group, uncheck the Label Features In This Class box.

d For Class, click the Class 1 down arrow and choose Create Label Classes From Symbology,
as shown in the following graphic.
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e In the Create Label Classes From Symbology dialog box, under Symbology Classes, uncheck
the Highway and Unclassified boxes.

f Click OK.

The data contains two more road classifications, but to save time, you will use a SQL
query to configure labels for the distribution and feeder roads only.

You do not need the default label class (Class 1), so you will delete it.

g In the Label Class group, for Class, confirm that Class 1 is selected.

h Click the SQL Query button .

i In the Label Class pane, in the upper-right corner, click the Menu button and choose
Remove Label Class.

j In the Label Class pane, click the Class down arrow and choose Distribution Road, if
necessary.

You will notice in the Label Class pane that an expression is automatically configured such that
only distribution roads are included in the label class.
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You will now change the font of the distribution roads to distinguish them from the feeder roads.

k In the Label Class pane, click the Symbol tab.

l Expand Appearance.

m Change Font Style to Bold.

The font style is applied automatically. Next, you will set label properties for feeder roads.

n In the Label Class pane, click the Class down arrow and choose Feeder Road.

o For Color, choose a brown color.

The color of the text automatically updates to a brown color.

p At the bottom of the Label Class pane, turn off the Auto Apply option.

q In the Contents pane, right-click Roads and choose Label, if necessary.

r Zoom in so that you can see the labels.

You may see different features, but you will notice that the labels differ based on the road type.
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You could also set scale ranges on each label class to further control what appears at various
scales.

s Save the project.

Step 5: View the labeling summary

Next, you will review the labeling summary for general quality assurance and performance of the
label classes that you created.

a In the Contents pane, verify that the Roads layer is selected.

b On the Labeling tab, in the Map group, click the More button and choose Summary.

The Labeling Summary dialog box displays information about the labeling classes in the map.
The summary report detects potential problems with labeling parameters that may affect
performance, readability, and the ability to convert labels to annotation. Your labeling classes
have no issues.

c Close the Labeling Summary dialog box.

Step 6: Convert labels to annotation

Next, you will convert the existing Roads labels to annotation so that you can individually
manage and edit your text.

First, you will change your map scale.
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a At the bottom left of the map view, change the current map scale by typing 1:250,000, as
indicated in the following graphic.

b Press Enter.

Next, you will convert labels to annotation.

c On the Map tab, in the Labeling group, click the Convert down arrow and choose Convert
Labels To Annotation.

d In the Geoprocessing pane, set or confirm the following parameters:

• For Input Map, confirm that Belize Symbology is selected.

• For Conversion Scale, confirm that it is set to 1:250,000.

• For Convert, choose Single Layer.

• For Feature Layer, choose Roads.

• For Output Geodatabase, confirm that BelizeProject.gdb is selected. If not, browse to ..\

EsriTraining\PROM\Belize\BelizeProject\BelizeProject.gdb.

You will accept the remaining defaults for converting your labels to annotation. The output
feature class will be named RoadsAnno, based on the Annotation Suffix parameter. Also, a
group layer named GroupAnno will be added to the map as a layer that references the
annotation feature class.

You can also create feature-linked annotation in ArcGIS Pro, which acts the same as in
ArcMap: if you delete a feature, then the associated annotation is also deleted.

e Click Run.

f In the Contents pane, expand GroupAnno, if necessary, and then expand RoadsAnno.
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Annotation was created for both labeling classes in your map. Switching the annotation layers
off and on from here allows you to individually edit each piece of text.

Step 7: Edit annotation

Next, you will practice using the Annotation tool to edit an individual text feature.

a At the lower left of the map, zoom to a 1:100,000 scale.

b On the Edit tab, in the Manage Edits group, click the Edit button .

c In the Tools gallery, click the Annotation tool.

d In the map, with the Annotation tool selected, click a piece of text to select it.

When you select text with the Annotation tool, a selection box displays. You can drag the box to
move the text, rotate the text, or drag the corners of the box to resize the text.

e Experiment with moving and resizing the text.

f At the bottom left of the map, above the scale, change the font for the text that you selected.

Editing annotation is similar to editing a point, line, or polygon feature—you must save your
edits.

g To apply the changes, press F2 or, at the bottom of the map, click the Finish button .

h On the Edit tab, in the Manage Edits group, click the Save button and then click Yes.

You may need to click away from the annotation that you were editing to enable the
Save button.

You converted labels to annotation and used the Annotation tool to edit the text of an individual
feature.

i Right-click any map view tab and choose Close All Views.
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j Notice that you have several panes open on the right side of your ArcGIS Pro interface.

You will use the Pane Sets option that you previously added to the Quick Access Toolbar.

k At the top of the application, from the Quick Access Toolbar, click the Pane Sets button
and choose Mapping.

By using Close All Views and the Pane Sets button, you were able to close all the views and reset
the panes without having to go to a different main tab.

l Save your project and exit ArcGIS Pro.
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1. In what three ways can you add text to features in ArcGIS Pro?

_______________________________________________________________________________________

2. How can you create unique labels for specific features based on an attribute or attribute
query?

_______________________________________________________________________________________
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Adding text using ArcMap (page 5-2)

Which methods does ArWhich methods does ArcMap offer for adding tecMap offer for adding text to a map?xt to a map?
Possible responses include the following methods:

• Using the Label Manager, either Maplex Label Engine or Standard Label Engine
• Creating a geodatabase annotation feature class
• Converting labels to map annotation
• Using graphic text to add individual annotations

Answers to lesson 5 questions
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You have symbolized and labeled vector data using various functionalities in ArcGIS Pro.
Although vector data is often used in mapmaking and analysis, raster data is also commonly
used. Raster data has its own symbology and display functionality and properties. In this
lesson, you will experiment with various display techniques for raster data. You will create
function chains, interpolate surfaces, and migrate a raster catalog to a mosaic dataset.

Topics covered

Raster management

Displaying raster data

Raster functions

6 Displaying raster data
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In addition to analyzing and visualizing vector data, ArcGIS has the functionality to manage
extensive volumes of imagery and raster data using mosaic datasets. A mosaic dataset is a
collection of raster datasets that can be stored, managed, queried, viewed as a single
mosaicked image, or viewed as individual images. Rasters can be viewed as a mosaic with
access to each raster dataset in the collection. A mosaic dataset can either be created in a
geodatabase where rasters are added directly or it can reference another mosaic dataset.
Creating a mosaic dataset in a geodatabase allows you to modify the properties and functions
applied per raster; a referenced mosaic dataset is read-only and cannot have more rasters
added. Mosaic datasets are available in ArcMap and ArcGIS Pro. In ArcGIS Pro, mosaic datasets
are preferred for storing rasters and are optimal for viewing and displaying raster data.

Figure 6.1. This collection of raster datasets is being viewed as a single mosaicked image.

ArcGIS Pro Help: Mosaic daMosaic datasetstasets
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ArcGIS Pro allows you to visualize raster data using three methods:

• Raster rendering

• Raster effects

• Raster resampling

Raster rendering

Raster rendering is the process of displaying your data. A renderer allows you to symbolize
raster data by visually enhancing your imagery and surfaces. The renderer depends on the type
of data that you have and what you want to show. There are additional renderers in ArcGIS Pro,
beyond the ones that are available in ArcMap. Depending on the type of raster data that you
have, only the symbology types that are valid for the data you have selected are presented.

RRenderendererer DescriptionDescription

Unique
Values

The Unique Values renderer displays each value in a raster layer individually
as a random color. Colors can be chosen by a color ramp, default colors, or
manually assigned. The Unique Values renderer can be used to display
thematic or qualitative rasters representing distinct objects on the earth's
surface, such as a land-use raster.

Stretch The Stretch renderer displays continuous raster cell values across a gradual
ramp of colors. This renderer is used to improve the display in rasters that
have a large range of values. It is primarily used for contrast stretching. The
Stretch renderer can be used when displaying rasters such as aerial imagery
or elevation models.

Classify The Classify renderer displays single-band thematic rasters by grouping cell
values into classes. This renderer is used to display continuous phenomena,
such as slope, distance, or suitability rasters.

Raster display
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RRenderendererer DescriptionDescription

Discrete The Discrete renderer uses a specific number of colors to display your dataset
of continuous phenomena. Each color represents a value, and when all the
colors have been used, it reuses the color scheme for the next set of values.

RGB The RGB renderer displays a composite image created by loading
multispectral bands into each red, green, and blue channel. This combination
can help highlight specific features on an image.

Shaded
Relief

The Shaded Relief renderer displays a 3D representation of terrain using
merged images from the elevation-coded and hillshade methods. You can
specify the color scheme for the color ramp to display your elevation or
terrain data.

Vector Field The Vector Field renderer uses a magnitude and direction, or a U and V,
component to display your data. Arrows can be used to indicate direction,
and the size of the arrow is related to the magnitude.

Raster effects

After you display your data, raster effects allow you to view underlying thematic data with your
imagery and to evaluate spatial relationships.

Transparency

Transparency reduces the opacity of all items in the chosen layer. When applied, it makes the
underlying layer or feature visible.
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Figure 6.2. In this example, the hillshade layer on the left is obscured when the elevation layer is placed on top
of it, as shown in the center image. The image on the right has transparency set to 50% for the elevation layer
and now shows the underlying hillshade symbology.

Layer blending

Layer blending draws the entire layer and then blends it with the content below it in the drawing
order.

Figure 6.3. In this example, the Thematic and Hillshade maps have been blended to create a lightening mode,
which results in a visibly lighter layer.

Raster resampling

The pixel differences within a raster can also be smoothed or enhanced by changing the
resampling type. The resampling type changes how rasters are displayed by adjusting the
display resolution and values to smooth out the appearance of rasters.

Raster display (continued)
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Figure 6.4. Rasters can be transformed using four resampling types: nearest neighbor, bilinear, cubic, and
majority.

• Nearest neighbor assigns the value from the closest pixel.

• Bilinear interpolates the new value based on a weighted distance average of the four

nearest pixels.

• Cubic performs a cubic convolution and determines the new value of a pixel based on

fitting a smooth curve through the sixteen nearest cell centers.

• Majority assigns the most popular value from the 4-by-4 filter window.

ArcGIS Pro Help: Imagery appeImagery appeararanceance

ArcGIS Pro Help: Change the symbology of imageryChange the symbology of imagery
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In ArcGIS Pro, you can work with raster data in numerous ways. A quick way to process and
analyze rasters in ArcGIS Pro is by using a raster function. Raster functions are operations
applied to the visible pixels of imagery or raster datasets that are in your map at the current
resolution.

You can apply raster functions to many types of rasters in ArcGIS Pro, including the following
raster types:

• Raster layers

• Mosaic datasets

• Raster items in mosaic datasets

• Image service layers

The functions provide instructions for displaying the resulting raster layers. Raster functions do
not create permanent data; the results of the function are stored in your current project only. To
save the results of a raster function, you can export them to a geodatabase or use
geoprocessing tools. Whether you use a function or a tool depends on the output that you want.

Raster functions

Displaying raster data
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Figure 6.5. When you have an elevation raster, you can apply functions to create virtual layers for hillshade and
slope in the map.

Function chains

If your workflow requires that you run several functions in succession on an input raster, you can
create a function chain. A function chain is a combination of raster functions that creates the final
output layer. You can then run the function chain rather than running each tool individually.

When using a function chain, the functions within it are performed as the data is accessed. For
example, if you want to extract specific bands, combine the bands in a new raster, and classify
the raster, you can use a function chain. For later use or collaboration, you can save function
chains as raster function templates in the project or use them in other projects.
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Though ArcGIS Pro provides the same options for raster display as ArcMap, there are some
notable differences in how the options are accessed. The following table outlines these
differences.

RRaster displayaster display
capabilitycapability

ArArcMapcMap ArArcGIS PcGIS Prroo

Raster symbology • Accessed from layer
properties

• Symbology pane, accessed from
the Raster Layer tab

Raster functions • Accessed from the
Image Analysis
window

• Raster Function pane, accessed
from the Analysis tab or the
Imagery tab

Raster effects
• Transparency
• Layer

blending

• Transparency:
Accessed from layer
properties

• Layer blending: Not
available

• Accessed from the Effects group
on the Raster Layer tab

Raster rendering
• Stretch type
• Resampling

type

• Accessed from layer
properties

• Accessed from the Rendering
group on the Raster Layer tab

Displaying raster data
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Imagine that you are a GIS analyst analyzing elevation data in Northridge, California. You will
work with several raster visualization operations to enhance the appearance of your data. You
will also use raster functions to create a hillshade layer and a composite image.

In this exercise, you will perform the following tasks:

• Modify raster data symbology.

• Use raster functions to derive new rasters.

Exercise 6
Use raster symbology and functions
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Step 1: Change raster background color

First, you will change the appearance of an elevation raster to remove background values.

a Start ArcGIS Pro and, under Recent Projects, open CourseProject.

The instructions in this box are only necessary if you do not see CourseProject in the
Recent Projects list. If you are unsure, ask your instructor for assistance.

1. Start ArcGIS Pro.

2. Click Open Another Project.

3. Browse to ..\EsriTraining\PROM\Projects\CourseProject and open

CourseProject.aprx.

b From the Insert tab, click New Map.

c Name the new map Northridge, CA.

d In the Catalog pane, expand the PROM folder, and then expand the Northridge folder.

e Expand the Northridge geodatabase.

f Add the Elevation raster dataset to your map.

g In the Contents pane, turn off the basemap layers (World Topographic Map and World
Hillshade).

Displaying raster data
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Elevation is displayed using a digital elevation model (DEM) with stretched symbology. White
cells indicate higher elevations, and black cells indicate lower elevations. In this DEM, much of
the area covered by black cells represents ocean. With Stretch symbology, you can set a
background color using the Display Background Value option. In this example, you can assume
that zero elevation represents ocean.

When you symbolize raster data, you use the Raster Layer tab. ArcGIS Pro is a context-sensitive
application—when you activate a raster layer in the Contents pane, the options on the tabs will
work only on raster data.

Next, you will change the background color of the elevation raster.

h In the Contents pane, select the Elevation layer.

i On the Raster Layer tab, in the Rendering group, click Symbology to open the
Symbology pane.

Click the Symbology icon, not the Symbology down arrow.

j Near the middle of the pane, click the Mask tab, and then check the Display Background
Value box.
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Checking the Display Background Value box allows you to display the background of a raster
dataset in a specific color or with transparency.

k Below Display Background Value, click the color swatch, as indicated in the following
graphic.

l Set the background color to Cretan Blue (row 3, column 10) to represent the water.

Displaying raster data
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In this step, you changed the background color of the raster to blue to represent water.

Step 2: Modify raster symbology

Next, you will symbolize your raster using an elevation color scheme to visualize terrain.

a At the top of the Symbology pane, for Primary Symbology, click the down arrow and choose
Classify.

b For Color Scheme, click the down arrow and choose Elevation #1.

Hint:Hint: You may need to check the Show Names box.
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The symbology colors might be different in your exercise results.

c Zoom in so that you can see the cell details.

The resampling type changes how rasters are displayed by adjusting the display resolution and
values to smooth out the appearance of the rasters. The default resampling type is Nearest
Neighbor, which has a blocky appearance. You will change the resampling type from the Raster
Layer tab.

Displaying raster data

6-15



d On the Raster Layer tab, in the Rendering group, click Resampling Type and choose Majority.

The Nearest Neighbor and Majority resampling types show slight differences but, overall, look
similar. You will experiment with another resampling type.

e Change the resampling type to Cubic.

The Cubic interpolator provides much smoother edges than does Nearest Neighbor or Majority,
giving the appearance of polygons rather than cells.

f Close the Symbology pane.

In this step, you symbolized the Elevation raster and used resampling to interpolate a smooth
appearance.

Step 3: Derive surfaces using the hillshade raster function

Next, you will apply raster functions to the Elevation layer to create derivative surfaces to
visualize terrain.

First, you will use hillshade to visualize terrain. Hillshade, or shaded relief, is a cartographic
technique used to visualize terrain by modulating light and shadows on a map.

a Zoom to the extent of the Elevation layer.
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b On the Analysis tab, in the Raster group, click Raster Functions .

Raster functions are operations that apply processing directly to the pixels of imagery and raster
datasets, as opposed to geoprocessing tools, which write out a new raster to disk. Several
surface analysis tools, such as hillshade, slope, and aspect, are available as functions in ArcGIS
Pro.

c In the Raster Functions pane, on the System tab, expand Surface and click Hillshade.

d In the Hillshade Properties pane, for Raster, choose Elevation.

e At the bottom of the Raster Functions pane, click Create New Layer.

The hillshade function created a terrain surface using slope, a light source, and the aspect of the
elevation surface on the Elevation raster.

f In the Contents pane, verify that Hillshade_Elevation is selected.

g On the Raster Layer tab, in the Effects group, set Transparency to 65%.

Displaying raster data
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The transparency helps reveal the underlying elevation color scheme and adds an aesthetic
quality to the shaded relief map.

Step 4: Use a raster function to create a composite raster layer

In this step, you will create a raster that combines four different rasters to create a composite
image.

First, you will add your rasters to the project and reorder them so that the features are easier to
see.

a Insert a new map and name it Louisiana.

b Turn off the basemap layers.

c In the Catalog pane, within the PROM folder, expand the Rasters folder.

d Select all four datasets and add them to your map.

e In the Contents pane, drag Band_1.tif to the top of the drawing order.
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Your results may look different depending on the order of the added raster layers. All the layers will be
symbolized using the stretch renderer and appear black and white by default.

Next, you will use the four rasters to create a composite image.

Remote sensing imagery commonly has multiple bands representing different wavelengths of
energy from along the electromagnetic spectrum. You can combine these bands into a
composite image using a raster processing function.

f In the Contents pane, look at each band individually to see differences by turning the layers
on and off.

g Turn all raster layers back on.

h On the Analysis tab, in the Raster group, click Raster Functions.

You will use raster functions to create raster products that are derived from other raster layers.

i In the Raster Functions pane, expand Data Management and click Composite Bands.

j On the Parameters tab, for Rasters, choose the four bands in the following order:

• Band_1

• Band_2

• Band_3

• Band_4
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k Click Create New Layer.

l Save your project.

In this step, you created the composite layer. The four bands are combined into one three-band
raster layer using a raster function.

m Close any open maps.

n On the View tab, in the Windows group, click the Pane Sets button and choose Mapping.

o Save your project and exit ArcGIS Pro.
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1. What is created when you run a raster function?

_______________________________________________________________________________________

2. You want to create a hillshade using a raster function and then save the raster for later
use. Which two steps should you take to accomplish this?

_______________________________________________________________________________________

_______________________________________________________________________________________

Lesson review

Displaying raster data

6-21





The ability to analyze spatial features and their attributes sets a true GIS apart from other
map-viewing applications, and using geoprocessing tools can increase the efficiency of your
daily GIS work. The analysis tools that are available in ArcMap are also available in ArcGIS
Pro, with ArcGIS Pro having more advanced capabilities. You will learn about the benefits of
analysis methods in ArcGIS Pro and how you can use geoprocessing tools in an analytical
setting.

Topics covered

Analysis in ArcMap and ArcGIS Pro

Using subsets of data in ArcGIS Pro

Migrating ArcMap resources to ArcGIS Pro

Creating analysis workflows using geoprocessing tools
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As an ArcGIS user, you may need to use geoprocessing tools to manage data, prepare data for
additional analysis, or answer spatial analysis questions.

There are three methods for performing analysis: using geoprocessing tools, using
ModelBuilder, and using Python. You may have used some of these methods in ArcMap, which
are also available in ArcGIS Pro.

Geoprocessing

Geoprocessing tools are sets of tools used to process and manage geographic data. Many
geoprocessing tools are spatial analysis tools. Geoprocessing tools perform an operation on a
dataset and usually create an output dataset. Running individual tools is the primary method of
performing analysis when you want to create another dataset that represents the results of the
tool, such as buffering a feature to find a specified distance or intersecting two features to find
their overlap. Geoprocessing tools can be run immediately or can be scheduled to run at a later
time. You can automate tools that you run regularly to run with recurrence. Many geoprocessing
tools can also be run in batch mode, that is, run multiple times on different datasets and with
different parameters. In ArcGIS Pro, you can perform the following actions:

• Create custom geoprocessing tools to automate work

• Use batch geoprocessing to run a tool multiple times

• Set geoprocessing tools as favorites for each project or the ArcGIS Pro application

• View geoprocessing history to review detailed information about the tools that were run

and which settings were used

ModelBuilder

ModelBuilder is a visual programming language available in ArcGIS that allows you to create
automated geoprocessing and data management workflows in an easy-to-understand visual
diagram. You can add geoprocessing tools to a model and chain them together to create an
analysis workflow. Models created in ArcMap can be migrated to ArcGIS Pro, but models
created or edited in ArcGIS Pro cannot be used in ArcMap.

Lesson 7
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Python

Python is an open-source programming language and the main scripting language used in
ArcGIS. You can use two different scripting interfaces, the Python window or ArcGIS Notebooks,
along with the ArcPy site package that ships with ArcGIS Pro, to programmatically access all
geoprocessing functionality to automate workflows. Because ArcMap uses Python 2 and ArcGIS
Pro uses Python 3, tools are available to highlight issues that would prevent the code or tools
from running when migrating Python code from ArcMap to ArcGIS Pro.

Any toolbox files with the .tbx extension are read-only in ArcGIS Pro 3.0+. The tools in
a read-only toolbox can be run but not modified. Moreover, the tools in a toolbox with
a .tbx extension can be copied to an ArcGIS toolbox (.atbx) to retain editing
functionality in ArcGIS Pro 3.0+.

Figure 7.1. ArcGIS Pro offers three methods for analyzing data: geoprocessing tools, ModelBuilder, and Python
scripting.

Analysis in ArcMap and ArcGIS Pro (continued)
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Tasks

Tasks are another useful capability in ArcGIS Pro. Tasks are a set of preconfigured steps used to
implement a workflow, improve the efficiency of a workflow, or create interactive steps. Tasks
can include any GIS task, such as zooming or editing a layer, running geoprocessing tools, or
sharing a map online.

ArcGIS Pro Help: Schedule geoprSchedule geoprocessing toolsocessing tools
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Imagine that you are performing an analysis of major earthquakes (of magnitude 7.0 or higher)
over the last 50 years. However, you have a dataset that contains all earthquakes, of any
magnitude, ever recorded. You can use ArcGIS Pro to define a subset of that data that contains
only the earthquakes that you are interested in. There are five ways to define a subset of data.

Selection tools

You can define a subset of data simply by selecting the data that you need. You can select the
data interactively on the map, or you can select it with the Select Layer By Attribute or Select
Layer By Location geoprocessing tools.

Figure 7.2. In this map of world earthquakes since 1970, earthquakes within 1 decimal degree of a tectonic plate
boundary are selected.

Highlighted records

If you have selected features on the map or in the attribute table, you can create a subset of
those selected features (in other words, you can create a selection within the selection).

Defining subsets of data
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Figure 7.3. The selected records (shown in cyan) in this attribute table represent earthquakes that caused a
tsunami. A subset of selected records (shown in yellow) represent earthquakes that caused a tsunami that also
have a magnitude greater than 7.0.

Definition queries

A definition query is similar to selecting features by attributes. However, a definition query will
display only the features that meet the requirements of the query, removing all other features in
the layer from the map.

Figure 7.4. In this map, a definition query limited the display to show only earthquakes of a magnitude of 7.0 or
higher.
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Time filter

Applying a time filter to time-aware data allows you to create a subset of the data that shows
only features that fall within the period of time defined by the filter. A time filter allows you to
step through a dataset sequentially.

Figure 7.5. In each of these maps, a time filter limited the display to show earthquakes that occurred in specific
decades. In ArcGIS Pro, the time filter is controlled using a slider.

Range filter

A range filter is similar to a time filter, but it is applied to numeric ranges rather than periods of
time. Like a time filter, a range filter allows you to step through a dataset sequentially.

Figure 7.6. In each map, a range filter limited the display to specific magnitudes of earthquakes. In ArcGIS Pro,
the range filter is controlled using a slider.

Activity questions

Use what you have learned about the options for defining a subset of data to support
geoprocessing in ArcGIS Pro to answer the following questions.

Defining subsets of data (continued)
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1. A GIS analyst wants to map sightings of a specific endangered bird species in New
South Wales, Australia. However, the dataset includes all endangered species sightings
in Australia. How could the GIS analyst restrict the display of the data to show only the
bird sightings of interest?

_______________________________________________________________________________________

_______________________________________________________________________________________

2. A GIS analyst is analyzing noise complaint calls related to a concert venue. How could
the GIS analyst use geoprocessing tools to run a proximity analysis that includes only
the noise complaints within a specified distance of the concert venue?

_______________________________________________________________________________________

_______________________________________________________________________________________
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Imagine that you are a GIS analyst and need to use subsets of data to perform analysis. Many
geoprocessing tools have parameters that support selections, definition query filters, and filters.
When an input with a selection or filter is added to a parameter in the geoprocessing tool, a
message indicates the selection or filter and the number of records. The tool processes only
those records limited by the selections and filters. You will discover different ways of selecting
and filtering subsets of data to use in your analysis.

In this exercise, you will perform the following tasks:

• Select a subset of features.

• Filter a subset of features.

• Use a subset in a geoprocessing tool.

Exercise 7A
Use subsets of data in ArcGIS Pro
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Step 1: Select a subset of features in the map

In this step, you will interactively select a subset of features in a map and then input those
features into a geoprocessing tool.

First, you will open your CourseProject and add a map.

a Start ArcGIS Pro and, under Recent Projects, open CourseProject.

The instructions in this box are only necessary if you did not already complete the
previous workflow to create BelizeProject and the Belize Symbology map in the
CourseProject ArcGIS Pro project. If you are unsure, ask your instructor for
assistance.

1. Start ArcGIS Pro.

2. Click Open Another Project.

3. Browse to ..\EsriTraining\PROM\Projects\CourseProject and open

CourseProject.aprx.

b Close any open maps, if necessary.

Hint:Hint: Right-click a view tab and choose Close All Views.

c Insert a new map into the project and change its name to Subsets.

d From Belize.gdb, add the Towns_2010_Belize layer to the map.

Hint:Hint: In the Catalog pane, under Folders, expand PROM and Belize, and then expand
Belize.gdb.
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e In the Contents pane, click Towns_2010_Belize twice slowly and rename the layer to
Towns_Belize.

Next, you will select a subset of features in the map using selection tools.

f Zoom in to the northern half of Belize.

Performing analysis
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g On the Map tab, in the Selection group, click the Select down arrow and choose Rectangle.

h Draw a box to select the three outer island features.
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i Notice the bottom right of the view.

Three features are selected in the map.

Next, you will see how selected features are recognized in a geoprocessing tool.

j On the Analysis tab, in the Geoprocessing group, click the Tools button .

k In the Geoprocessing pane, in the search field, type export features.

l Click the Export Features (Conversion Tools) tool.

m For Input Features, choose Towns_Belize.
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When you add an input with a selection to a parameter in the Geoprocessing pane, a message
indicates the selection and the number of records. By default, the toggle is turned on to process
the selected records, but the toggle can be turned off to process all records. This option will be
discussed later in the exercise. You will keep the toggle turned on to use the selected records.

n In the Geoprocessing pane, click the Back button .

In this step, you interactively selected features in the map to use as input in a geoprocessing
tool.

Step 2: Filter a subset of features using a definition query

In this step, you will create a subset of features using a different method. You will build a
definition query to use in a geoprocessing tool.

First, you will build a definition query.

a On the Map tab, in the Selection group, click the Clear button .

b In the Contents pane, right-click the Towns_Belize layer and choose Zoom To Layer.
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c In the Contents pane, select the Towns_Belize layer, if necessary.

d On the ribbon, click the contextual Data tab.

e In the Definition Query group, click the Build Definition Query button .

The Layer Properties dialog box opens with the Definition Query tab already selected.

A definition query allows you to define a subset of features to work with in a layer by filtering
which features are retrieved from the dataset by the layer.

f Click New Definition Query.

g For the first field, click the down arrow and choose TYPE.

h Confirm that the second field is set to Is Equal To.
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i For the third field, click the down arrow and choose City.

The definition query should read Where TYPE Is Equal To City.

j Click Apply, and then click OK.
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In this step, you filtered your map to show two features with City as the TYPE attribute.

Step 3: Use a subset to buffer features

In this step, you will buffer the features filtered from the definition query to show how filtered
features are recognized in a geoprocessing tool.

a In the Geoprocessing pane, in the search field, type buffer.

b Click the Buffer (Analysis Tools) tool.

Information about the Pairwise Buffer tool appears at the top of the tool. For the
purposes of this exercise, you can ignore this information.

c For Input Features, choose the Towns_Belize layer.
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The toggle is on, so the number of records that will be processed with the filter is two.

d In the Buffer pane, set the following parameters:

• For Output Feature Class, type Towns_Buffer_5mi.

• Under Distance [Value Or Field], type 5.

• Under Linear Unit, choose US Survey Miles.

e Accept all remaining parameters and click Run.
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A new Towns_Buffer_5mi layer is added to your map and shows two towns with five-mile buffers.

f In the Contents pane, select the Towns_Belize layer.

g On the Data contextual tab, in the Definition Query group, click the down arrow and choose
<None>.
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All Towns_Belize features now appear on the map. Towns with an attribute of City are shown with
a five-mile buffer.

h Save the project and exit ArcGIS Pro.

Selections and filters allow you to work with a subset of records without editing the data. In this
exercise, you focused on multiple areas of interest in the data to use as inputs in a
geoprocessing tool.
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Although the geoprocessing methods are similar, you have access to more geoprocessing tools
and greater functionality using models and Python in ArcGIS Pro. There are also differences in
the way that the geoprocessing methods are accessed. Additionally, the ability to import both
models and Python scripts requires evaluation to ensure that items will run in ArcGIS Pro without
any additional work.

Accessing geoprocessing methods

The following table summarizes how to access geoprocessing methods in ArcMap and ArcGIS
Pro.

AnalysisAnalysis
methodmethod

ArArcMapcMap ArArcGIS PcGIS Prroo

Geoprocessing
tools

• Located in the
Geoprocessing
toolbox

• Located on the Analysis tab

Models • Accessed in
ModelBuilder

• Accessed in ModelBuilder
• Imported models with custom tools

must be analyzed for errors

Python • Uses Python 2 • Uses Python 3
• Imported scripts from ArcMap must

be analyzed for errors

Exploring geoprocessing resources in ArcGIS Pro
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Imagine that you are a GIS analyst and need to find highways that run through protected areas
with fire risk in Belize. You will add a map for analysis and use a suite of geoprocessing tools to
perform spatial analysis and manage data. You will then visualize the results in a map.

In this exercise, you will perform the following tasks:

• Select features.

• Buffer a feature.

• Clip to an area.

• Intersect an area.

• Explore and symbolize analysis results.

Exercise 7B
Perform spatial analysis
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Step 1: Add a map for analysis

Before starting your analysis on protected areas with fire risk in Belize, you will create a map that
contains the data that you need to perform analysis.

a Start ArcGIS Pro and, under Recent Projects, open CourseProject.

The instructions in this box are only necessary if you do not see CourseProject in the
Recent Projects list. If you are unsure, ask your instructor for assistance.

1. Start ArcGIS Pro.

2. Click Open Another Project.

3. Browse to ..\EsriTraining\PROM\Projects\CourseProject and open

CourseProject.aprx.

b Close any open maps.

c Insert a new map into the project and change its name to Fire Risk Analysis.

d From Belize.gdb, add the following layers to the map:

• Firerisks_Belize

• ProtectedAreas_2014_Belize

• Roads_2013_Belize

Hint:Hint:In the Catalog pane, under Folders, expand PROM and Belize, and then expand
Belize.gdb. You can press and hold Ctrl to select multiple layers at one time.

e In the Contents pane, click Roads_2013_Belize twice slowly and rename the layer to
Roads_Belize.

f Repeat this process to rename ProtectedAreas_2014_Belize to ProtectedAreas_Belize.

g If necessary, in the Contents pane, move ProtectedAreas_Belize above Firerisks_Belize.
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h Save your project.

Step 2: Select features

To obtain the desired analysis result, you will create a model that uses three polygon layers as
input: highway corridors, protected areas, and fire risk areas. You will prepare the existing
Roads_Belize layer for the model by selecting only the highway features and then buffering the
highway features by 1,000 feet.

You could also prepare the highway corridors layer in the model. Because you do not
expect the highways to change frequently, you are choosing to create the highway
corridors layer by running geoprocessing tools instead.

In this step, you will use the Roads_Belize layer to select only the highway features.

a On the Analysis tab, in the Geoprocessing group, click the Tools button .

b In the Geoprocessing pane, in the search field, type select.

c Click the Select (Analysis Tools) tool.

d In the Select pane, set the following parameters:

• For Input Features, choose Roads_Belize.

• For Output Feature Class, type Highways.

Here, you will build an expression to select highways in the roads layer.

e For Expression, after Where, set the first field to Road_Type.

f Confirm that the second field is set to Is Equal To.

g For the third field, choose Highway.
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Your expression should read Where Road_Type Is Equal To Highway.

h Click Run.

A new Highways layer, containing only roads that are highways, is added to your map.

Step 3: Buffer a feature

In this step, you will buffer the highway features by 1,000 feet to create a polygon layer that
represents highway corridors. The buffered highways layer will be used as input to a model.

a In the Geoprocessing pane, click the Back arrow .

b In the Geoprocessing pane, clear the search field and type buffer.

c Click the Buffer (Analysis Tools) tool.

Information about the Pairwise Buffer tool appears at the top of the tool. For the
purposes of this exercise, you can ignore this information.
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d In the Buffer pane, set the following parameters:

• For Input Features, choose Highways.

• For Output Feature Class, type Highway_Corridors.

• Under Distance [Value Or Field], type 1000.

• Under Linear Unit, choose US Survey Feet.

e Accept all remaining parameters and click Run.

A new Highway_Corridors layer that buffers highways by 1,000 feet is added to your map.

Step 4: Clip to an area

In this step, you will create a model that finds highways that run through protected areas with fire
risk in Belize. By creating a model, you can rerun the analysis anytime the input layers change,
such as the areas of fire risk.

You will now create a model to analyze fire risk.

a On the Analysis tab, in the Geoprocessing group, click ModelBuilder.

b In the Catalog pane, expand Toolboxes, and then expand the CourseProject.atbx to verify
that the model has been automatically added.
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c On the ModelBuilder tab, in the Model group, click Properties.

d In the Tool Properties dialog box, set the following parameters:

• For Name, type FireRiskModel.

• For Label, type Fire Risk Model.

• For Description, type Find highways in protected areas that have fire risk.

e Click OK.

f On the ModelBuilder tab, in the Model group, click the Save button .

Next, you will configure the model to clip the highway corridors to show only highways in
protected areas.

g In the Geoprocessing pane, click the Back arrow .

h In the Geoprocessing pane, clear the search field and type clip.

i Drag the Clip (Analysis Tools) tool to the Fire Risk Model view.

j In the model view, double-click the Clip tool to open it.

k In the Clip dialog box, set the following parameters:

• For Input Features Or Dataset, choose Highway_Corridors.

• For Clip Features, choose ProtectedAreas_Belize.

• For Output Features Or Dataset, type Highways_In_ProtectedAreas.
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l Click OK.

The Highway_Corridors and ProtectedAreas_Belize layers are added as variables to the model,
the Clip tool turns yellow, and the output turns green.

Step 5: Intersect an area

You will now configure the model to intersect the highways in protected areas with fire risk
areas.

a In the Geoprocessing pane, clear the search field and type intersect.

b Drag the Intersect (Analysis Tools) tool to the Fire Risk Model view, as shown in the following
graphic.

c Close the Geoprocessing pane.

d In the model view, double-click the Intersect tool to open it.

e In the Intersect dialog box, set the following parameters:

• For Input Features, choose Highways_In_ProtectedAreas and Firerisks_Belize.
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• For Output Feature Class, type Highways_In_ProtectedAreas_With_FireRisk.

f Click OK.

The Firerisks_Belize layer is added as a variable to the model, the Intersect tool turns yellow, and
the output turns green.

g On the ModelBuilder tab, in the View group, click the Auto Layout button .

h On the ModelBuilder tab, in the Model group, click the Save button .

In ArcGIS Pro, ModelBuilder has an autosave option, so the model saves as you build
it.

Step 6: Configure the analysis parameters

Now that you have added tools to the model, you will define the names of the analysis
parameters. The parameters that you configure in this step will show as inputs when the model is
run as a geoprocessing tool.

a In the model view, right-click Highway_Corridors and choose Rename.

b Replace the existing name with Buffered highway features and press Enter.

Performing analysis

7-29



c Repeat this process to rename the other model variables based on the following table:

VVariable nameariable name New nameNew name

ProtectedAreas_Belize Protected area features

Firerisks_Belize Fire risk area features

Highways_In_ProtectedAreas_With_FireRisk Output feature class

Next, you will designate the analysis parameters in the model.

d Right-click Buffered Highway Features and choose Parameter.

An output feature class will be automatically added to the active map when it is set as a
parameter. If it is not set as a parameter, you can use Add To Display to have it added to the
active map.

e Repeat this process to set Protected Area Features, Fire Risk Area Features, and Output
Feature Class as parameters.

f Save the model.

g Close the Fire Risk Model view.

Next, you will run the model as an analysis tool in the geoprocessing pane.

h In the Catalog pane, under Toolboxes, expand CourseProject.atbx, if necessary, and double-
click Fire Risk Model.

You will notice that the model opens as a tool in the Geoprocessing pane. The tool parameters
match the names of the parameters that you configured in the model.
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i Accept the default values in the tool.

j Click Run.

The Highways_In_ProtectedAreas_With_FireRisk layer is added to the Contents pane.

Step 7: Visualize the results

Next, you will visualize the geoprocessing results in a map.

a In the Contents pane, right-click the symbol for Highways_In_ProtectedAreas_With_FireRisk
and choose Solar Yellow (row 3, column 5).

b Right-click Highways_In_ProtectedAreas_With_FireRisk and choose Attribute Table.

c In the attribute table, to the left of the first row, right-click the blue box numbered 1 and
choose Zoom To.

d Close the attribute table.

e On the Feature Layer tab, in the Compare group, click Swipe .

f In the map view, swipe up to down or right to left.

You will notice that the Highways_In_ProtectedAreas_With_FireRisk layer shows areas that are
within 1,000 feet of highways and located in protected areas that are in fire risk areas.

g Close any open maps.

h On the View tab or the Quick Access toolbar, click the Pane Sets button and choose
Mapping.

i Save your project and exit ArcGIS Pro.
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In addition to the analysis methods that are available in ArcMap, ArcGIS Pro has new analysis
workflows that you can use to answer complex spatial questions and lead to new perspectives in
your decision-making. Spatial analysis workflows can be used to solve complex location-
oriented problems, discover patterns and relationships, or detect change over time. ArcGIS Pro
has many guided workflows and methods to help you perform spatial analyses that go beyond
what ArcMap offers. Some of the most popular workflows are highlighted below.

Suitability modeling

Although suitability analysis can be performed in various ways with ArcGIS software, the
Suitability Modeler in ArcGIS Pro is an interactive, exploratory environment for creating and
evaluating a suitability model. Suitability modeling can identify the best locations to site or
preserve. For example, you could use a suitability model to determine the best location to build
a restaurant or the best area to preserve for a park. A suitability model is created by determining
the criteria data, transforming the values of each criterion to a common suitability scale,
weighting criteria and combining them to create a suitability map, and locating areas for siting
or for preservation. You can share suitability models with your organization.

Figure 7.7. The Suitability Modeler created a map with the most suitable areas displayed in green.

Lesson 7

Analysis workflows in ArcGIS Pro

7-32



Exploratory 3D analysis

Exploratory 3D analysis allows you to investigate data through an interactive spatial analysis of a
scene. You can understand how the local terrain and other 3D features obstruct the line of sight
between an observer and a target, the impact analysis from the direct view of the central
location point, and whether there is elevation change along a proposed vehicle route. You can
share the results of your scene as an image or PDF.

Figure 7.8. In this example, exploratory 3D analysis created an interactive viewshed showing what can and
cannot be seen from a certain location. Obstructed areas are shown in pink and unobstructed areas are in green.

Network analysis

Network analysis enables organizations to run their vehicle routing operations more efficiently
through strategic routing plans, creation of drive-time buffers or service areas, coordination of
vehicles, and determination of least-cost network paths between several origins and
destinations. Network analysis can be used to answer questions like the following:

• What is the quickest way to get from point A to point B?

• What is the nearest gas station from my current location?

Analysis workflows in ArcGIS Pro (continued)
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• Where should a new store be located to maximize potential customers?

You can then easily share and communicate your plans using network analysis across your
organization.

Figure 7.9. In this example, network analysis determined the quickest route from point A to point B.
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1. Describe the analysis methods that are available in ArcGIS Pro.

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

2. When performing an analysis, such as a buffer, how do you know whether there is an
active definition query or a selection on an input layer?

_______________________________________________________________________________________

_______________________________________________________________________________________
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Defining subsets of data (page 7-5)

1.1. A GIS analyst wants to map sightings of a specific endangerA GIS analyst wants to map sightings of a specific endangered bired bird species in Newd species in New
South WSouth Wales, Australes, Australia. Howeveralia. However, the da, the dataset includes all endangertaset includes all endangered speciesed species
sightings in Austrsightings in Australia. How could the GIS analyst ralia. How could the GIS analyst restrict the display of the daestrict the display of the data tota to
show only the birshow only the bird sightings of interd sightings of interest?est?

They could create a definition query that specifies that the map should display only

sightings of the specific bird species in New South Wales.

2.2. A GIS analyst is analyzing noise complaint calls rA GIS analyst is analyzing noise complaint calls relaelated to a concerted to a concert venue. Howt venue. How
could the GIS analyst use geoprcould the GIS analyst use geoprocessing tools to run a processing tools to run a prooximity analysis thaximity analysis thatt
includes only the noise complaints within a specified distance of the concerincludes only the noise complaints within a specified distance of the concert venue?t venue?

The GIS analyst could select the relevant noise complaint points by their locations. The

geoprocessing tool would include only the selected points in the analysis.
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In this course, you have displayed, edited, and analyzed data using ArcGIS Pro to discover
solutions for various scenarios. In this lesson, you will learn about layout elements, how to
import your ArcMap layouts, and how to create an informative layout in ArcGIS Pro. Whether
adding a north arrow, a scale bar, or multiple map frames, ArcGIS Pro provides solutions for
numerous layout scenarios. You will also learn how data-driven pages in ArcMap compare to
a map series in ArcGIS Pro.

Topics covered

Creating a layout

Creating a map series
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In ArcMap, a page layout is a collection of layout elements designed for map printing. Think
about your use of layouts in ArcMap, and then answer the following questions.

What are some layout elements that you can add to your page layout in ArcMap?

If you wanted to generate a series of layout pages from a single map document in
ArcMap, which workflow would you use?
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Although you can create layouts in both ArcMap and ArcGIS Pro, there are differences in how
the layouts are created. In ArcMap, data frames are added to the layout automatically. If you
want to add a second map to your layout in ArcMap, you have to insert a new data frame. If you
choose not to have a map in your layout in ArcMap, you must delete that data frame. In ArcGIS
Pro, you add map frames to a layout. You can add any number of map frames using any map in
your ArcGIS Pro project. In ArcGIS Pro, layouts are added to a project when you import an
ArcMap document.

New layout capabilities in ArcGIS Pro include predefined page sizes from the gallery,
autoresizing of elements when changing size or orientation, locking elements to prevent
selection or modification, and the ability to pan or zoom the original map without affecting the
corresponding map frame in the layout. An ArcGIS Pro layout can be exported as a layout file to
be used as a template for creating new layouts with consistent formatting.

Building layouts in ArcGIS Pro

Creating layouts
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Figure 8.1. The elements that are available in ArcMap can also be used in ArcGIS Pro. Layout elements include a
title, map frame, grid or north arrow, scale bar, extent indicator, and legend.

Lesson 8

Building layouts in ArcGIS Pro (continued)

8-4



Imagine that you have created a map of the San Juan National Forest in ArcMap and have
imported the map document into ArcGIS Pro. You will create a layout in ArcGIS Pro and add the
proper supporting elements for your data around the Vallecito Reservoir. You will save your
layout as a layout file for other analysts to use.

In this exercise, you will perform the following tasks:

• Create a layout.

• Add and modify layout elements.

• Save a layout file.

Exercise 8A
Create a layout in ArcGIS Pro
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Step 1: Create a layout

First, you will insert a new layout and add guides to help you more easily align your layout
elements.

a Start ArcGIS Pro and, under Recent Projects, open GetStarted.

The instructions in this box are only necessary if you did not already complete the
previous workflow to import the San Juan National Forest map to GetStarted. If you
are unsure, ask your instructor for assistance.

1. Start ArcGIS Pro.

2. Click Open Another Project.

3. Browse to ..\EsriTraining\PROM\Results\Exercise01\GetStarted and open

GetStarted.aprx.

b If necessary, close any open maps and layouts.

c On the Insert tab, in the Project group, click New Layout and, under ANSI - Portrait, choose
Letter 8.5" x 11", as indicated in the following graphic.
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A blank layout opens. Before you add a map frame, you will add guides to the layout view.

d Above the layout, right-click the horizontal ruler and choose Add Guide.

e Point to the ruler on the guide until the blue placement arrow appears.

f Drag the blue arrow to the 0.5-inch mark on the ruler.

g Repeat this process to add a guide at the 8-inch mark on the horizontal ruler.

h From the vertical ruler on the left side of the layout view, add guides at the 1-inch mark and
the 10-inch mark.

You will now use the guides to add the San Juan National Forest map frame to the layout.

i On the Insert tab, in the Map Frames group, click Map Frame.

j Under San Juan National Forest, click Default Extent.

k In the layout view, drag your cursor from the upper-left intersection of the guides to the
lower-right intersection of the guides, as shown in the following graphic.
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l On the left side of the layout, right-click the vertical ruler and choose Remove All Guides.

You can also remove individual guide lines by right-clicking the ruler and choosing
Remove Guide.

You will now prepare the layout by turning off the layer that you do not need. This layer was
included in the map that was imported from ArcMap.

m In the Contents pane, under the San Juan National Forest map frame, turn off the Forest
layer.

You will rename the layout.

n In the Contents pane, change Layout to Vallecito Reservoir.

o Save the project.

Step 2: Locate an area of interest

Before adding your layout elements, you will zoom to the approximate location of the Vallecito
Reservoir.
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a On the Layout tab, in the Map group, click the Activate button .

Activating allows you to zoom and pan in the map frame instead of the layout page. If you want
to alter the map extent as you create the layout, you can use the Activate functionality.

b On the Map tab, in the Inquiry group, click the Locate button .

c In the Locate pane, in the Search field, type Vallecito Reservoir, CO, USA and press Enter.

d Zoom in on Vallecito Reservoir to a scale of 1:36,000.

Hint:Hint: In the scale bar in the lower-left corner, type 36,000 and press Enter.

e Close the Locate pane.

Next, you will add a basemap that highlights the elevation in the area.

f From the Map tab, add the Topographic basemap.

g From the Layout tab, click the Close Activation button .

h Save the project.

You have located the Vallecito Reservoir and added a basemap. You are now ready to add
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layout elements to the layout page.

Step 3: Add a map title

You will now add a map title to your layout. Most elements are on the Insert tab.

a On the Insert tab, in the Graphics And Text group, click the Text Gallery down arrow .

b Click the Straight Text button .

c At the top of the layout, where you want to place the title, draw a horizontal box.

A Text element is added to the Contents pane.

Each layout contains a Contents pane. As you add elements to your layout, you will also see
them added to the Contents pane. Each element has a lock icon next to it. Similar to ArcMap,
you can select, move, and resize elements. After you modify an element to your satisfaction, you
can lock it. Locking prevents you from accidentally altering an element while working on your
layout. You can also turn elements off and on from the layout Contents pane.

d In the Contents pane, double-click Text to open the Element pane.

e In the Element pane, in the text box, type Vallecito Reservoir Trails and Recreation.

You can also perform in-line text editing in the layout by double-clicking the text
element.

f In the text box, right-click Vallecito and choose Add To Custom Dictionary.

You will now change the size of your title.

g At the top of the Element pane, click the Text Symbol tab.

h If necessary, expand Appearance.
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i For Size, type 30 and press Enter.

j Click Apply.

If you have Auto Apply enabled, you will not see the Apply button and your changes
will be applied automatically.

k If necessary, in the layout view, center the title.

l In the Contents pane, to the left of Text, click the lock icon .

With the Text element now locked, you cannot accidentally select or modify the title. However, if
you did want to modify the title, you would simply click the lock icon again to unlock the
element.

m Save the project.

Step 4: Add a north arrow

Next, you will add a north arrow to your layout.

a On the Insert tab, in the Map Surrounds group, click the North Arrow down arrow.

b Below North Arrows, choose ArcGIS North 1 (the first option in the gallery), as shown in the
following graphic.

c In the lower-left corner of the layout, click to add the north arrow.
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d In the Contents pane, lock the North Arrow element.

e Save the project.

In this step, you added a north arrow to your layout to help orient map readers.

Step 5: Add a scale bar

Scale bars help map readers understand the distance between features on the map page.
ArcGIS Pro has many scale bars to choose from. You will add a scale bar to the layout.

a On the Insert tab, in the Map Surrounds group, click the Scale Bar down arrow.

b Under Metric, choose Alternating Scale Bar 1 Metric, as shown in the following graphic.

c Draw a horizontal box at the bottom of the layout page.

The distances in your scale bar may be different, depending on the size of the box
that you drew.

d If necessary, adjust the scale bar so that the labels do not overlap.
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If you change the scale of the map frame, the scale bar dynamically changes to match
the updated scale.

e In the Contents pane, lock the Scale Bar element.

f Rotate the wheel on your mouse to zoom in to the layout page, so that you can more clearly
see the scale bar.

The Layout tab contains useful operations for zooming in and out of the page. The Layout tab
also contains functionality to manage rulers and guides and to select elements. Next, you will
pan across the layout page.

g From the Layout tab, in the Navigate group, click the Navigate button .

h Click the map and drag to pan across the layout page.

i In the Contents pane, right-click Map Frame and choose Zoom To Page.

j Save the project.

Step 6: Add a legend

Next, you will add a legend to the layout page.

a From the Insert tab, in the Map Surrounds group, click Legend.

b In the map frame, draw a box in the top-right corner to temporarily place the legend.

Next, you will reorder your layers so that roads appear at the bottom, because there are multiple
road types.

c In the Contents pane, expand Legend and drag Roads to the bottom of the list.
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You will now rename the Recreation_Sites layer.

d In the Contents pane, under Map Frame, click Recreation_Sites twice slowly.

e Rename the layer to Recreation Sites and press Enter.

You will notice that the map layer name and legend text are updated.

f Resize and reposition the legend on the layout page.

g Save the project.

In this step, you added a legend to your layout.

Step 7: Save a layout file

Next, you will save the layout file of the Vallecito Reservoir so that you can share it with other
users.

a Ensure that the Vallecito Reservoir layout is the active layout.

b On the Share tab, in the Save As group, click Layout File.

The Save Layout As Layout File dialog box opens.

Layout files store the layout definition and can be used like templates. You can then use the
layout file to create a layout rather than starting with a blank layout.

c Browse to ..\EsriTraining\PROM\San Juan National Forest, accept the default name, and click
Save.

d From the Insert tab, click New Layout.
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e At the bottom of the layout size gallery, click Import Layout File.

f Browse to ..\EsriTraining\PROM\San Juan National Forest, select the layout file that you just
created, and click OK.

The layout appears just as you saved it. Other users with ArcGIS Pro and access to the data could
view and work with your layout. If you decided to change the size of your layout, ArcGIS Pro
would automatically adjust the layout elements, although you might have to make minor
adjustments to some elements.

g On the Layout tab, in the Page Setup group, click Size and choose Legal.

h Close any open maps and layouts.

i On the View tab or the Quick Access toolbar, click the Pane Sets button and choose
Mapping.

j Save your project and exit ArcGIS Pro.

Creating layouts

8-15



With ArcMap, users can create a multipage layout using data-driven pages. The same output
can be created in ArcGIS Pro but is referred to as a map series. The workflow and how you
access the tools to create a map series in ArcGIS Pro are much different than for data-driven
pages in ArcMap.

In an ArcGIS Pro spatial map series, the features of any layer can be used as a spatial reference,
where each map extent is defined by a feature layer. Features become a page in the final output,
such as a multipage PDF.

Figure 8.2. In this example in ArcGIS Pro, a spatial map series uses a feature layer of the provinces of Canada to
create a page for each feature, or province.

ArcGIS Pro has the additional capability to create a map series using bookmarks. Users can
create bookmarks, with each bookmark becoming a page in the final output.
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Figure 8.3. In this example in ArcGIS Pro, a bookmark map series uses bookmarks of Canadian cities to create a
page for each feature, or city.

You can also use a group layer to create a thematic map series, which shows only one layer at a
time in the map.

ArcMap data-driven pages versus ArcGIS Pro map series (continued)
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Figure 8.4. In this example in ArcGIS Pro, a thematic map series uses a group layer showing land-cover types in
Canada to create a page for each layer in the group layer.
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As a spatial analyst for the San Juan National Forest, you need to create a map book of the lakes
within the forest. You will import an existing ArcMap document and create a map series using
bookmarks. You will also add a graticule and dynamic layout elements.

In this exercise, you will perform the following tasks:

• Import an ArcMap map document.

• Create a map series.

• Add and modify layout elements.

• Export the map series.

Exercise 8B
Create a map series in ArcGIS Pro
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Step 1: Import an ArcMap map document

Before you make your map, you will import an ArcMap document with saved bookmarks of the
lakes in the forest.

a Start ArcGIS Pro and, under Recent Projects, open CourseProject.

The instructions in this box are only necessary if you do not see CourseProject in the
Recent Projects list. If you are unsure, ask your instructor for assistance.

• Start ArcGIS Pro.

• Click Open Another Project.

• Browse to ..\EsriTraining\PROM\Projects\CourseProject and open

CourseProject.aprx.

b If necessary, close any open maps and layouts.

Your current ArcGIS Pro project does not have the necessary bookmarks needed to create a
map series of the lakes in the San Juan National Forest. However, you have an ArcMap
document that contains the necessary bookmarks. You will import the ArcMap document to add
the bookmarks to your Pro project.

c In the Catalog pane, under the PROM folder connection, expand the San Juan National
Forest folder.

d Right-click DataDrivenPages.mxd and choose Import And Open.

By importing the San Juan National Forest ArcMap document, a new map and layout are added
to the project.

e On the Map tab, in the Navigate group, click the Bookmarks button .
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The bookmarks in the ArcMap map document have been imported into the project.

f Save the project.

Step 2: Prepare a map series

Next, you will prepare the map series by renaming the map and adding a basemap.

a In the Contents pane, change the name of the map to San Juan Lakes.

You will now add a basemap.

b On the Map tab, in the Layer group, click the Basemap button and choose Topographic.

c Click the Bookmarks button and choose Lemon Reservoir.
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You renamed the map and added a basemap in preparation for creating a map series.

d Save the project.

Step 3: Create the map series

Next, you will create the map series using the data-driven page layout to create a map series
from bookmarks.

a From the Catalog pane, expand Layouts.

b Double-click DataDrivenPages to open the view.
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The layout opens and the map frame is set to the default extent of the San Juan Lakes map.

c Rename the layout to San Juan Lakes.

d Save your project.

Step 4: Enable the map series using bookmarks

Next, you will enable the map series using bookmarks.

a On the Insert tab, in the Map Frames group, click the Map Series down arrow and choose
Bookmark.

b In the Layout Properties dialog box, on the Map Series tab, notice that all your bookmarks
have already been added.
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c Click OK.

d Notice that your map frame has changed to the first bookmark, Electra Lake.

e In the Contents pane, view the Map Series Pages list.

All bookmarks are listed in the pane. Double-clicking each page in the map series automatically
changes the data frame to that lake's bookmark.

f Save the project.

Step 5: Add dynamic text

Next, you will add a title and page numbers as dynamic text. Dynamic text will change based on
the current properties of the project, layout, map frame, and so on.

First, you will add a title using a dynamic page name.

a On the Insert tab, in the Graphics And Text group, click the Dynamic Text button .

b Scroll down to the Map Series group and choose Page Name, as shown in the following
graphic.
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c At the top of your layout, draw a box where you would like the title to display.

Your title displays Page Name: Electra Lake. Because you just want the name of the lake, you will
format the dynamic text to remove Page Name.

d In the layout, double-click the title to open the Element pane.

e In the Options group, under Text, click inside the box to edit.

f Delete Page Name: from the text box.

Next, you will change the size of your title.

g In the Element pane, click the Text Symbol tab.

h Expand Appearance.

i Change Size to 26 pt, and then click Apply.

Your map now has the page name of the lake.

Next, you will add a dynamic page number.

j On the Insert tab, in the Graphics And Text group, click the Dynamic Text button .
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k In the Map Series group, choose Page With Count.

l At the bottom of your layout, draw a box where you would like the page number to display.

m At the bottom of the Contents pane, click the arrow that is shown in the following graphic.

n Continue to click the arrow to review each page.

By adding dynamic layout elements, the map frame, title, and page number all change based
on the page in the map series.

Step 6: Add a legend

Next, you will add a legend to the layout page.

a From the Insert tab, in the Map Surrounds group, click Legend.

b In the map frame, draw a box where you would like your legend to display.

c In the Contents pane, click the List By Drawing Order button .

d Expand Legend and drag Roads to the bottom of the list.

e Resize and reposition the legend on the layout page.

f Save the project.

In this step, you added a legend to your layout.
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Step 7: Add a graticule

Next, you will add a graticule to provide map readers with coordinate information for the area in
the map of each lake.

a In the Contents pane, select the Map Frame element.

b On the Insert tab, in the Map Frames group, click Grid and choose Gray Horizontal Label
Graticule.

Your map appears with a graticule.

c Save the project.

Step 8: Export the map series to a PDF

Imagine that you now want to share your layout with someone who does not have ArcGIS Pro. To
do so, you will share the layout as a PDF.

You will first export the map series to a PDF.
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a On the Share tab, in the Output group, click the Export Layout button to open the Export
Layout pane.

Do not click the Export Layout down arrow.

b In the Export Layout pane, for Name, browse to ..\EsriTraining\PROM\San Juan National
Forest.

c In the Export Layout dialog box, for Name, type San Juan Lakes Map Book.

d Click OK.

You will notice that you have the option to save the current export properties as a
preset template. This option enables users to export layouts with properties that meet
an organization's standards.

e In the Export Layout pane, click Export.

f Open File Explorer, browse to ..\EsriTraining\PROM\San Juan National Forest, and view the
PDF of the map book.

g Close the PDF and File Explorer.

h Close any open maps and layouts in ArcGIS Pro.

i On the View tab or the Quick Access toolbar, click the Pane Sets button and choose
Mapping.

j Save your project and exit ArcGIS Pro.
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1. What are some similarities and differences between creating layouts in ArcMap and
ArcGIS Pro?

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

2. What are the methods for creating a map series in ArcGIS Pro?

_______________________________________________________________________________________

_______________________________________________________________________________________
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Sharing your work has always been an important part of creating GIS maps and performing
analysis. ArcGIS Pro offers the same sharing options that you are used to working with in
ArcMap. However, ArcGIS Pro also enables you to share projects, layers, web layers, web
maps, and tile packages. In the past, you may have shared your work—a shapefile, for
example—through email. The recipients would have then had to share a feature service to
create a web map. With ArcGIS Pro, you can author web maps directly in the application,
rather than sharing a service from ArcMap and then authoring the web map in ArcGIS
Online. You can also share layers and data using ArcGIS Online, and you can limit access to
content to yourself (private), a group, your organization, or the public. In this lesson, you will
explore sharing content in ArcGIS Pro.

Topics covered

Sharing items in ArcGIS

How the portal is used in ArcGIS Pro

Sharing and accessing content across the ArcGIS system

9 Sharing content
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Based on your knowledge of ArcMap, answer the following question.

What kinds of content created in ArcMap can be shared with others?

Lesson 9
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Whether you are using ArcMap or ArcGIS Pro, you can share your work. In the ArcGIS system,
users can share their desktop items, such as project templates or packaged items, as well as
web items. ArcGIS Pro improves the functionality and ease of sharing by integrating with the
portal. With ArcGIS Pro, you can share desktop items like project templates, or package layers,
maps, and projects that include a copy of the associated data. You can also publish web items
like layers and maps so that others can access them through your organization's portal.

Files

There are files stored locally on your computer, such as layer files, that store item definitions. An
item definition can include the following information:

• Coordinate system of the map

• Definition queries

• Layer, map, and project settings

• Appearance or symbology

Although files do not include data, they can reference datasets. In ArcMap, files include layer
files and map templates. In ArcGIS Pro, files include map files, layer files, layout files, report files,
and style files.

Map files (.mapx), layer files (.lyrx), layout files (.pagx), and report files (.rptx) cannot be
opened in ArcGIS Pro 2.x if the files were created or saved in ArcGIS Pro 3.0+.

Packages

A package is a desktop file that includes the established aspects of a project, like a file with the
addition of referenced data. You can use packages to share data with team members or to
create an archive of your data. Each package includes the files required for the share recipient to
open and use the items. A package contains a compressed file of GIS data and, depending on
the package, can also contain layers, maps, layouts, connections, and all associated project-level
settings.

Sharing items in ArcMap and ArcGIS Pro
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Packages include a project package, map package, layer package, mobile map package,
geoprocessing package, and many more.

Web items

You can use web items to share data with a broad range of team members, whether the team
members are using one of the ArcGIS apps or accessing the data using the web. Web items are
stored and managed in a portal. To open a web item, you only need access to the portal. Items
shared to the portal are accessed through a web browser, so they are accessible from desktop
computers, tablets, and even mobile devices. Common types of web items include web feature
layers, web maps, and web apps. Web feature layers are collections of geographic data that are
used to create maps and scenes. Web feature layers are used for map visualization, editing, and
querying and can contain features, web tiles, and vector tiles.

If you want to create and publish a web map with ArcMap, you must first publish a feature
service and then build the web map from it in ArcGIS Online or ArcGIS Enterprise. With ArcGIS
Pro, however, you can create a web map and publish it directly to the portal from your desktop
mapping application. You can create web items in a portal, or you can share an item to a portal
from ArcGIS Pro.

The following table lists some of the files, packages, and web items that can be shared in
ArcMap and ArcGIS Pro:

Item to sharItem to sharee ArArcMapcMap ArArcGIS PcGIS Prroo

Layer file

Map file

Layout file

Layer package

Map package

Lesson 9
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Item to sharItem to sharee ArArcMapcMap ArArcGIS PcGIS Prroo

Geoprocessing package

Project package

Project template

Web feature layer

Web map

Web scene

Web style

Web tools

Sharing items in ArcMap and ArcGIS Pro (continued)
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In the ArcGIS system, portals can be used to share maps, layers, and packages. With ArcMap,
you can connect to a portal and publish services, but it is more common to share maps and data
using packages. These packages, essentially zipped files, can be emailed or stored in a shared
file drive or folder location. ArcGIS Pro is more integrated (with access to both ArcGIS Online
and Portal for ArcGIS, a component of ArcGIS Enterprise), and it easily publishes, accesses, and
works with services from a portal that enables others to view and interact with GIS content via
the web. Although you can still use a portal to share files for users to access and download, a
portal accessed by ArcGIS Pro can also house services so that users have access to data without
making copies.

The following types of services can be published from ArcGIS Pro:

• Feature services allow users to view, query, and edit feature data and nonspatial tables.

• Map services make maps, features, and attribute data available as a map image layer.

• Image services allow users to access raster and image data on the web.

• Geoprocessing services (ArcGIS Enterprise only) collect geoprocessing tools to perform

tasks that are necessary for manipulating and analyzing geographic information.

Lesson 9
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Figure 9.1. This map service is one of the items that is managed in a portal. Any device with web access can
open, use, and view this map.

Using services in ArcGIS Pro (continued)
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An ArcGIS portal allows you to manage your data and content in order to integrate with other
systems and apps. ArcGIS provides many options to manage a portal:

• Esri can manage a portal for your organization using ArcGIS Online.

• Your organization can manage a portal using ArcGIS Enterprise.

• Your organization can use a combination of ArcGIS Online and ArcGIS Enterprise.

The ArcGIS portal is the member-management and content-management system.

Member management

Each member of your organization is provided a unique identity. This unique identity is tied to
an account that the member uses to sign in to the organization's portal. The account defines
what the member can do, what items they can access, and which of Esri's ready-to-use apps they
can use.

Content management

The portal manages items that you create, add, and share. These items can be data files, web
maps, web apps, and so on. The items are collectively referred to as content. The content is
stored and managed on the web. Storing these items on the web makes them more accessible
and easier to integrate into other apps and business systems.

Sharing levels

After you create a map, a package, or other item, several sharing levels are available. The
sharing level that you choose determines who can see and access your items. Before assigning a
sharing level, you might consider the following questions:

• Is the item useful to others?

• Does the item contain sensitive information?

• Is it okay for everyone—including anonymous users—to see the item?

Lesson 9
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The following table describes the three sharing levels that can be assigned to items in ArcGIS
Pro. Items can also be shared with specific groups, regardless of sharing level.

Item sharingItem sharing
levellevel

DescriptionDescription

Owner Only the item owner can access and share this item with a group. The
organization's administrators can also access this item.

Organization Only members of the organization can access and share this item with a
group.

Everyone
(Public)

Anyone can access and share this item with a group.

An administrator can prevent sharing outside the organization, thereby making public
sharing available only to administrators.

Groups

Sharing with a specific group restricts access to a smaller, more focused set of people. The
item's sharing level determines which ArcGIS Online members can share the item with a group:

• If the item is shared only with the owner, then the owner can share the item with a group.

• If the item is shared with the organization, then any member in the organization can share

the item with a group.

• If the item is shared with everyone, then people outside the organization can share the item

with a group.

Using a portal in ArcGIS (continued)
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Figure 9.2. Owner, Organization, and Everyone (Public) are the sharing levels for items in ArcGIS Online. The
Everyone (Public) sharing level is the broadest, providing access to anyone. The Organization sharing level is
smaller and exclusive to individuals within an organization. The Owner sharing level is the most limited, with
only the owner having access to share the item. An item can also be shared with a group, regardless of its
sharing level.
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ArcGIS Online's ability to manage users and content makes it a useful tool for accessing items
that can enhance maps, analysis, and visualization. Content can be accessed in various ways
through ArcGIS Online.

• Gallery: Access content from your organization that you can view and potentially use in

your work.

• Map: Perform mapping tasks in Map Viewer (modify symbology, perform analysis, and

edit), create web maps, and share content.

ArcGIS Online resources

Sharing content
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• Scene: Visualize and analyze your data in a 3D environment.

• Content: Access content that you created and shared from ArcGIS Pro or that you created in

ArcGIS Online.

Lesson 9
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Imagine that you are a spatial analyst and have created two maps in ArcMap. You want to import
the maps into ArcGIS Pro and share several items with your colleagues. You will share a web
feature layer of the San Juan National Forest so that other analysts in your group can access and
edit your work. You will then share a read-only web map of fire risks in Belize for others in your
group to view. Finally, you will view other group members' work and view your items in ArcGIS
Online.

In this exercise, you will perform the following tasks:

• Share a web layer to ArcGIS Online.

• Share a web map to ArcGIS Online.

• Access shared content in ArcGIS Pro.

• View shared resources on ArcGIS Online.

Exercise 9
Share items using ArcGIS Pro
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Step 1: Import an ArcMap map document

In this step, you will import an ArcMap map document of the San Juan National Forest that you
will share as a web layer for other analysts in your group to work with.

First, you will import an ArcMap map document of the San Juan National Forest.

a Start ArcGIS Pro and, under Recent Projects, open CourseProject.

The instructions in this box are only necessary if you do not see CourseProject in the
Recent Projects list. If you are unsure, ask your instructor for assistance.

1. Start ArcGIS Pro.

2. Click Open Another Project.

3. Browse to ..\EsriTraining\PROM\Projects\CourseProject and open

CourseProject.aprx.

b On the Insert tab, in the Project group, click Import Map.

c Browse to ..\EsriTraining\PROM\San Juan National Forest, select Share.mxd, and click OK.

The map contains several layers from the San Juan National Forest in Colorado.
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d Save the project.

In this step, you imported a map document. You are now ready to start sharing.

Step 2: Share a web layer

Next, you will prepare and share a web feature layer for editing.

a In the Contents pane, right-click the Layers map and choose Properties.

b On the General tab, for Name, type San Juan Web Layer, and then click OK.

c On the Share tab, in the Share As group, click Web Layer.

Be sure to click the Web Layer button and not the down arrow.

All feature layers in your map will be saved to the web layer, so you do not need to select a
specific feature layer.

d In the Share As Web Layer pane, set or confirm the following parameters:

• For Name, type SanJuanForest_<your initials and today's date>.

• For Summary, type Web layer containing various feature layers from San Juan National

Forest, Colorado.

• For Tags, type Colorado, San Juan.

• For Layer Type, choose Feature.

• For Groups, choose your class group.

e Click Analyze to identify warnings or errors with the data sources or layer properties.

An error message shows that the map properties need to be changed to allow the assignment
of unique numeric IDs when sharing web layers. Although you can share a web layer that
contains warnings, you must resolve any errors before sharing a web layer. You will fix this error
message by changing the map properties.

f In the Share As Web Layer pane, right-click the error message.

Sharing content
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g Choose Open Map Properties To Allow Assignment.

h In the Map Properties: San Juan Web Layer dialog box, check the Allow Assignment Of
Unique Numeric IDs For Sharing Web Layers box.

You can disregard the warning that appears because you are sharing the web layer for the first
time. If you needed to overwrite an existing web layer, then you would verify that the unique ID
for each layer matched the corresponding layer's ID in the published web layer.

i Click OK.

j In the Share As Web Layer pane, notice that the error message now has a green check mark
next to it, indicating that you resolved it.

Two warning messages state that a layer's pop-up definition includes fields that are not
supported online. You will ignore these warning messages because the formatting will be
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removed after the layer is shared.

Next, you will add a raster basemap layer before sharing the web feature layer.

k On the Map tab, in the Layer group, click the Basemap button and choose Imagery.

l Click Analyze again to verify whether the warnings have been addressed.

A new warning message states that the layer's data source is not supported in a web layer. You
will ignore this warning for now. Later in the exercise, you will see what happens with the
basemap when you open the layer in ArcGIS Online.

Next, you will configure the web feature layer so that others can edit the features.

m In the Share As Web Layer pane, click the Configuration tab, and then, next to Feature, click
the Configure Web Layer Properties button .

n Under Operations, check the boxes to enable editing and allow editors to add, delete, and
update; to enable sync; and to enable export operations.

• Enable Editing allows users to add, update, and delete features.

• Enable Sync allows users to work with a local copy of the data offline and to synchronize

changes when they are back online.

• Export Data allows users to export the data to different formats.

o Click Publish.

Sharing content
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Depending on the size of the web layer, sharing can take several minutes.

p After the web layer finishes publishing, close the Share As Web Layer pane.

q Save the project.

In this step, you shared a web layer that others in your group can edit, and you resolved
associated errors.

Step 3: Share a web map

Next, you will share an imported ArcMap map document of fire risks in Belize as a read-only web
map from ArcGIS Pro to your group for others to view.

First, you will import the map into ArcGIS Pro.

a On the Insert tab, in the Project group, click Import Map.

b Browse to ..\EsriTraining\PROM\MapDocuments, select BelizeWebMap.mxd, and click OK.

Your imported map of Belize is ready to be shared for others in your group to use as a
foundation for other layers.

c On the Share tab, in the Share As group, click Web Map.
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d In the Share As Web Map pane, set the following parameters:

• For Name, type BelizeWebMap_<your initials and today's date>.

• For Summary, type This map contains custom layer files for Belize that highlight fire risk

areas and ecosystems in relation to towns and roads.

• For Tags, type Belize, ecosystems, fire risk.

To configure the map as read-only, you must select the appropriate sharing option.

e Click the Select A Configuration down arrow.

There are three options for controlling how the web layers are published:

1. Exploratory creates an interactive map that supports queries, publishes feature data as

web feature layers, and publishes other data as web tile layers.

2. Editable gives you an Exploratory map, but with editing enabled for the feature layers.

3. Visualization yields a faster-rendering map with all tiled layers, not web feature layers.

f Choose Visualization.

g For Groups, check the box next to your class group.

h Click Analyze.

Two errors appear. You can quickly resolve the first error by adding a basemap.

i Add the Topographic basemap.

Sharing content
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j In the Share As Web Map pane, click Analyze again.

A new error states that the service layer has a different projection from that of the map. You must
match the projection of the Layers map to that of the Topographic basemap layer before you
can share.

k In the Contents pane, right-click World Topographic Map and choose Properties.

l Click the Source tab, and then expand Spatial Reference.

The service layer uses WGS 1984 Web Mercator (auxiliary sphere).

m Close the Layer Properties dialog box.

Next, you will change the coordinate system of the map to match the basemap.

n In the Contents pane, right-click the Layers map name and choose Properties.

o Click the Coordinate Systems tab.

The coordinate system of the map is WGS 1984 UTM Zone 16N. To share the map as a web
map, you must change the coordinate system to match the basemap.

p Under XY Coordinate Systems Available, if necessary, expand Layers to view all coordinate
systems in the current map.
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q Select WGS 1984 Web Mercator (Auxiliary Sphere) and click OK.

r In the Share As Web Map pane, click Analyze.

The errors no longer exist.

s Click Share.

After sharing is complete, a success message appears at the bottom of the Share As Web Map
pane.

t Close the Share As Web Map pane.

In this step, you shared a web map to your group for other analysts to view, resolving associated
errors prior to sharing.

Step 4: Access shared content in ArcGIS Pro

You will view another group member's web layer and web map by adding the items to your
project from ArcGIS Online.

First, you will add another group member's web layer of the San Juan National Forest.

a On the Insert tab, in the Project group, click New Map.

b In the Catalog pane, click the Portal tab.

c If you do not already see your class group, click the My Groups button .

d To the right of Content, click the Groups button, as shown in the following graphic.
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e Double-click your class group.

f Click the Menu button and choose Refresh.

g Right-click another group member's SanJuanForest web layer and choose Add To Current
Map.

The data is the same data that you worked with earlier, but it is now hosted on ArcGIS Online.

You also want to access a web layer, so you will view its data source.

h In the Contents pane, expand the SanJuanForest web layer.

i Right-click any layer and choose Properties.

j In the Layer Properties dialog box, click the Source tab, if necessary.

Your URL will differ from the one shown in this graphic.

Because the data is hosted on ArcGIS Online, the source displays a URL rather than a folder
path.

k Click OK.

Before using the data, you will verify that you can edit it.

l On the Edit tab, in the Manage Edits group, click the Edit button .

m In the Features group, click the Create button to view the Create Features pane.

As you can see, the web layer is editable. You can add, delete, or modify features and attributes
in any of the layers.
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Next, you will add your group member's web map of Belize to your project.

n In the Catalog pane, verify that you are viewing your class group's content.

o Locate one of the BelizeWebMap items shared by another group member.

p Right-click the web map and choose Add And Open.

The web map opens in ArcGIS Pro and is ready for use.

q On the Edit tab, if necessary, activate editing and then, in the Features group, click the
Create button.

The feature layers are tile layers, so you cannot make changes to the data.

r Close the Create Features pane.

s Save your project and exit ArcGIS Pro.

In this step, you added another group member's web layer and web map and you viewed the
respective editing capabilities of the layer and the map in ArcGIS Pro.

Step 5: View shared items in ArcGIS Online

Now that your project is complete, you will view your shared resources from ArcGIS Online.

First, you will sign in to ArcGIS Online.

a Open a web browser.

b On the ArcGIS Online home page (www.arcgis.com), click Sign In.
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c Type the organizational account username and password provided by your instructor and
click Sign In.

d At the top of the page, click Groups, and then find and select your class group.

You should see the web layers and web maps created by the group.

Next, you will edit your web layer's item description.

e Locate your SanJuanForest feature layer and click its name to view the layer properties.

You should always add item description information for shared content.

f To the right of Description, click Edit.

g In the Edit Description box, type Web layer of San Juan National Forest features created for
training class, and then click Save.

h Scroll down to Terms Of Use, click Edit, and then type For training purposes only and click
Save.

In the Layers section, each feature layer is listed and can be accessed and exported individually.

i At the top right of the page, click Open In Map Viewer.

The SanJuanForest web layer opens in Map Viewer. Users who do not have ArcGIS Pro can work
with your content in Map Viewer by, for example, modifying map symbology and editing layers.

You will also open the Belize web map item that you shared in ArcGIS Online.

j At the top left of the page, click the Menu button and choose Content.

k If a prompt appears, confirm that you want to leave the page.

l Locate your BelizeWebMap web map item and click its name to view the map properties.

From ArcGIS Online, you can open a web map in Map Viewer, ArcMap, ArcGIS Pro, or ArcGIS
Field Maps. You can create a presentation, create a web app, and share the map. If an
organization has enabled metadata, a Metadata button also appears here; owners or
administrators can use the Metadata button to access a built-in editor and include additional
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standards-based metadata.

m At the top right of the page, click Open In Map Viewer.

Your web map opens in Map Viewer. In ArcMap, you would have shared a feature service, added
the feature service to Map Viewer in ArcGIS Online, and then created the web map. In ArcGIS
Pro, you can author the web map and share it from your desktop GIS software.

n If necessary, zoom in to view the map features.

o Close the browser.

In this step, you edited an item description and opened both your web layer and your web map
in Map Viewer for future use.
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1. What are some ways in which you can use ArcGIS Pro to share work with others?

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

2. If you wanted to ensure that only members of your portal had access to an item, which
sharing level would you use?

_______________________________________________________________________________________
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ArcMap sharing options (page 9-2)

WhaWhat kinds of content crt kinds of content creeaated in Arted in ArcMap can be sharcMap can be shared with others?ed with others?
Possible responses include the following examples:

• Map packages
• Layer packages
• Layer files
• Locator packages
• Tile packages
• Geoprocessing packages
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ENVIRONMENTAL SYSTEMS RESEARCH INSTITUTE, INC. ("ESRI"), IS WILLING TO LICENSE THE
ENCLOSED ELECTRONIC VERSION OF THE TRAINING MATERIALS TO THE STUDENT ("YOU")
ONLY UPON THE CONDITION THAT YOU ACCEPT ALL TERMS AND CONDITIONS
CONTAINED IN THIS ESRI DATA LICENSE AGREEMENT ("AGREEMENT"). PLEASE READ THE
TERMS AND CONDITIONS CAREFULLY. BY CLICKING, "I ACCEPT", YOU ARE INDICATING
YOUR ACCEPTANCE OF THE ESRI DATA LICENSE AGREEMENT. IF YOU DO NOT AGREE TO
THE TERMS AND CONDITIONS AS STATED, ESRI IS UNWILLING TO LICENSE THE TRAINING
MATERIALS TO YOU.

Training Materials Reservation of Ownership. This Agreement gives You certain limited rights to
use electronic and tangible versions of the digital or printed content required to complete a
course, which may include, but are not limited to, workbooks, data, concepts, exercises, and
exams ("Training Materials"). Esri and its licensor(s) retain exclusive rights, title, and ownership to
the copy of Training Materials, software, data, and documentation licensed under this
Agreement. Training Materials are protected by United States copyright laws and applicable
international copyright treaties and/or conventions. All rights not specifically granted in this
Agreement are reserved to Esri and its licensor(s).

Grant of License. Esri grants to You a personal, nonexclusive, nontransferable license to use
Training Materials for Your own training purposes. You may run and install one (1) copy of
Training Materials and reproduce one (1) copy of Training Materials. You may make one (1)
additional copy of the original Training Materials for archive purposes only, unless Esri grants in
writing the right to make additional copies.

Training Materials are intended solely for the use of the training of the individual who registered
and attended a specific training course. You may not (i) separate the component parts of the
Training Materials for use on multiple systems or in the cloud, use in conjunction with any other
software package, and/or merge and compile into a separate database(s) or documents for
other analytical uses; (ii) make any attempt to circumvent the technological measure(s) (e.g.,
software or hardware key) that effectively controls access to Training Materials; (iii) remove or
obscure any copyright, trademark, and/or proprietary rights notices of Esri or its licensor(s); or
(iv) use audio and/or video recording equipment during a training course.
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Term. The license granted by this Agreement will commence upon Your receipt of the Training
Materials and continue until such time that (1) You elect to discontinue use of the Training
Materials or (2) Esri terminates this Agreement for Your material breach of this Agreement. This
Agreement will be terminated automatically without notice if You fail to comply with any
provision of this Agreement. Upon termination of this Agreement in either instance, You will
return to Esri or destroy all copies of the Training Materials, including any whole or partial copies
in any form, and deliver evidence of such destruction to Esri, and which evidence will be in a
form acceptable to Esri in its sole discretion. The parties hereby agree that all provisions that
operate to protect the rights of Esri and its licensor(s) will remain in force should breach occur.

Limited Warranty. Esri warrants that the media on which Training Materials is provided will be
free from defects in materials and workmanship under normal use and service for a period of
ninety (90) days from the date of receipt.

Disclaimer of Warranties. EXCEPT FOR THE LIMITED WARRANTY SET FORTH ABOVE, THE
TRAINING AND TRAINING MATERIALS CONTAINED THEREIN ARE PROVIDED "AS IS,"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, AND NONINFRINGEMENT. ESRI DOES NOT WARRANT THAT THE TRAINING OR
TRAINING MATERIALS WILL MEET YOUR NEEDS OR EXPECTATIONS; THAT THE USE OF
TRAINING MATERIALS WILL BE UNINTERRUPTED; OR THAT ALL NONCONFORMITIES,
DEFECTS, OR ERRORS CAN OR WILL BE CORRECTED. THE TRAINING DATABASE HAS BEEN
OBTAINED FROM SOURCES BELIEVED TO BE RELIABLE, BUT ITS ACCURACY AND
COMPLETENESS, AND THE OPINIONS BASED THEREON, ARE NOT GUARANTEED. THE
TRAINING DATABASE MAY CONTAIN SOME NONCONFORMITIES, DEFECTS, ERRORS, AND/
OR OMISSIONS. ESRI AND ITS LICENSOR(S) DO NOT WARRANT THAT THE TRAINING
DATABASE WILL MEET YOUR NEEDS OR EXPECTATIONS, THAT THE USE OF THE TRAINING
DATABASE WILL BE UNINTERRUPTED, OR THAT ALL NONCONFORMITIES CAN OR WILL BE
CORRECTED. ESRI AND ITS LICENSOR(S) ARE NOT INVITING RELIANCE ON THIS TRAINING
DATABASE, AND YOU SHOULD ALWAYS VERIFY ACTUAL DATA, SUCH AS MAP, SPATIAL,
RASTER, OR TABULAR INFORMATION. THE DATA CONTAINED IN THIS PACKAGE IS SUBJECT
TO CHANGE WITHOUT NOTICE. IN ADDITION TO AND WITHOUT LIMITING THE PRECEDING
PARAGRAPH, ESRI DOES NOT WARRANT IN ANY WAY TRAINING DATA. TRAINING DATA MAY
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NOT BE FREE OF NONCONFORMITIES, DEFECTS, ERRORS, OR OMISSIONS; BE AVAILABLE
WITHOUT INTERRUPTION; BE CORRECTED IF ERRORS ARE DISCOVERED; OR MEET YOUR
NEEDS OR EXPECTATIONS. YOU SHOULD NOT RELY ON ANY TRAINING DATA UNLESS YOU
HAVE VERIFIED TRAINING DATA AGAINST ACTUAL DATA FROM DOCUMENTS OF RECORD,
FIELD MEASUREMENT, OR OBSERVATION.

Exclusive Remedy. Your exclusive remedy and Esri's entire liability for breach of the limited
warranties set forth above will be limited, at Esri's sole discretion, to (i) replacement of any
defective Training Materials; (ii) repair, correction, or a workaround for Training Materials; or (iii)
return of the fees paid by You for Training Material that do not meet Esri's limited warranty,
provided that You uninstall, remove, and destroy all copies of the Training Materials and execute
and deliver evidence of such actions to Esri.

IN NO EVENT WILL ESRI BE LIABLE TO YOU FOR COSTS OF PROCUREMENT OF SUBSTITUTE
GOODS OR TRAINING; LOST PROFITS; LOST SALES; BUSINESS EXPENDITURES;
INVESTMENTS; BUSINESS COMMITMENTS; LOSS OF ANY GOODWILL; OR ANY INDIRECT,
SPECIAL, EXEMPLARY, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF OR
RELATED TO THIS AGREEMENT, HOWEVER CAUSED OR UNDER ANY THEORY OF LIABILITY,
EVEN IF ESRI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. ESRI'S TOTAL
CUMULATIVE LIABILITY HEREUNDER, FROM ALL CAUSES OF ACTION OF ANY KIND, WILL IN
NO EVENT EXCEED THE AMOUNT ACTUALLY PAID BY YOU FOR THE PORTION OF THE
TRAINING UNDER THIS AGREEMENT. THESE LIMITATIONS WILL APPLY NOTWITHSTANDING
ANY FAILURE OF ESSENTIAL PURPOSE OF ANY LIMITED REMEDY.

Export Regulation. You must comply with all applicable laws and regulations of the United
States including, without limitation, its export control laws. You expressly acknowledge and
agree not to export, reexport, transfer, or release Esri-provided Training Materials, in whole or in
part, to (i) any US embargoed country (including to a resident of any US embargoed country); (ii)
any person or entity on the US Treasury Department Specially Designated Nationals List; (iii) any
person or entity on the US Commerce Department Lists of Parties of Concern; or (iv) any person
or entity where such export, reexport, or provision violates any US export control laws or
regulations including, but not limited to, the terms of any export license or licensing provision
and any amendments and supplemental additions to US export laws.
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Governing Law. This Agreement is governed by and construed in accordance with the laws of
the state in which training is being held or, in the case of training provided over the Internet, the
laws of the State of California, without reference to its conflict of laws principles.
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Answers to lesson 1 review questions

1.1. Which default components arWhich default components are genere generaated when you crted when you creeaate an Arte an ArcGIS PcGIS Prro pro project file?oject file?
ArcGIS Pro project files include the following items by default: a home folder, a default

geodatabase and toolbox, default styles and locators, and a connection to your active

portal.

2.2. How do ArHow do ArcMap dacMap data frta frames imporames import into Art into ArcGIS PcGIS Prro?o?
ArcMap data frames import as maps in ArcGIS Pro.

Answers to lesson 2 review questions

1.1. If you wanted to designaIf you wanted to designate a default unit of mete a default unit of measurasurement in Arement in ArcGIS PcGIS Prroo, a, at which levelt which level
would you configurwould you configure thae that sett setting?ting?
Project level

2.2. In the CIn the Caatalog pane, is the Ftalog pane, is the Favorites tab an applicaavorites tab an application-level configurtion-level configuraation or a prtion or a project-oject-
level configurlevel configuraation?tion?
Application-level configuration

3.3. WhaWhat can you use to standart can you use to standardize prdize project contents for your oroject contents for your organizaganization?tion?
Project template

Answers to lesson 3 review questions

1.1. How do you starHow do you start and stop an edit session in Art and stop an edit session in ArcGIS PcGIS Prro?o?
An edit session starts when you modify existing data or create data. An edit session

stops when edits are saved or discarded.
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2.2. In ArIn ArcMapcMap, you must star, you must start and stop edit sessions, and you edit one workt and stop edit sessions, and you edit one workspace aspace at a time.t a time.
How is this prHow is this process differocess different in Arent in ArcGIS PcGIS Prro?o?
By default, in ArcGIS Pro, you are not required to manually start and stop edit sessions,

but you can set an option to turn editing off. When this option is activated, you can also

choose whether you edit a single workspace or multiple workspaces.

Answers to lesson 4 review questions

1.1. Explain the similarities and differExplain the similarities and differences between symbolizing feences between symbolizing feaaturtures in Ares in ArcMap andcMap and
symbolizing fesymbolizing feaaturtures in Ares in ArcGIS PcGIS Prroo..
Most of the same symbology options exist in both ArcMap and ArcGIS Pro; however, in

ArcGIS Pro, the tools are context-sensitive. The active layer in ArcGIS Pro is the layer that

you will modify. In ArcMap, the selected layer does not control the available tools.

2.2. How do you imporHow do you import a style file frt a style file from Arom ArcMap into ArcMap into ArcGIS PcGIS Prro?o?
Use the style import functionality to add a style that is stored locally on your system.

Local styles are part of the ArcMap installation on your machine.

Answers to lesson 5 review questions

1.1. In whaIn what thrt three ways can you add teee ways can you add text to fext to feaaturtures in Ares in ArcGIS PcGIS Prro?o?
You can add text using labels, annotation, and graphic text.

2.2. How can you crHow can you creeaate unique labels for specific fete unique labels for specific feaaturtures based on an aes based on an atttribute or atribute or atttributetribute
query?query?
You can create a label class based on the attribute field.

Answers to lesson 6 review questions

1.1. WhaWhat is crt is creeaated when you run a rted when you run a raster function?aster function?
A new layer
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2.2. YYou want to crou want to creeaate a hillshade using a rte a hillshade using a raster function and then save the raster function and then save the raster for laaster for laterter
use. Which two steps should you takuse. Which two steps should you take to accomplish this?e to accomplish this?
Answers may include the following:

• Use the Export Raster pane (right-click a layer and choose Data > Export Raster).
• Use the Generate Raster From Raster Function geoprocessing tool.

Answers to lesson 7 review questions

1.1. Describe the analysis methods thaDescribe the analysis methods that art are available in Are available in ArcGIS PcGIS Prroo..
The following analysis methods are available in ArcGIS Pro:

• Geoprocessing tools: Geoprocessing tools can be used to perform analysis and
manage data.

• ModelBuilder: Models use geoprocessing tools that allow you to create visual
workflows.

• Python scripting: Python scripting can be used to access all geoprocessing
functionality programmatically to automate tasks.

• Tasks: Tasks are a set of preconfigured steps used to implement a workflow,
improve the efficiency of a workflow, or create interactive steps.

2.2. When performing an analysis, such as a bufferWhen performing an analysis, such as a buffer, how do you know whether ther, how do you know whether there is ane is an
active definition query or a selection on an input layer?active definition query or a selection on an input layer?
When using an input layer with a definition query or selection, a message indicates the

selection or filter status and the number of records that will be processed.
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Answers to lesson 8 review questions

1.1. WhaWhat art are some similarities and differe some similarities and differences between crences between creeaating layouts in Arting layouts in ArcMap andcMap and
ArArcGIS PcGIS Prro?o?
Answers may include the following:

• Similarities:

• Layouts include similar elements in ArcMap and ArcGIS Pro.
• Differences:

• ArcGIS Pro has a Layout tab rather than a toolbar.
• You can lock layout elements in ArcGIS Pro.
• ArcGIS Pro supports multiple layouts in one project; ArcMap supports only one

layout.
• In ArcGIS Pro, you can turn layout elements off and on from the Contents pane.

2.2. WhaWhat art are the methods for cre the methods for creeaating a map series in Arting a map series in ArcGIS PcGIS Prro?o?
You can create different map series types by using a spatial index layer, bookmarks, or a

radio group layer.

Answers to lesson 9 review questions

1.1. WhaWhat art are some ways in which you can use Are some ways in which you can use ArcGIS PcGIS Prro to sharo to share work with others?e work with others?
ArcGIS Pro can be used to share your work or access shared content. You can save items

such as files and packages locally and then email them to others. Or you can save items

to a shared network drive. You can also use a portal to share work—such as web maps,

web layers, and packages—and access shared content from others.

2.2. If you wanted to ensurIf you wanted to ensure thae that only members of your port only members of your portal had access to an item, whichtal had access to an item, which
sharing level would you use?sharing level would you use?
Organization
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Lesson 1 Resources

ArcGIS Pro interface and
structure •• ArArcGIS PcGIS Prro Help:o Help: NavigaNavigationtion

Lesson 2 Resources

Project templates
•• ArArcGIS PcGIS Prro Help:o Help: CrCreeaate a prte a project templaoject templatete

Lesson 4 Resources

Sources of symbology
styles •• ArArcGIS PcGIS Prro Help:o Help: SStylestyles

•• ArArcGIS PcGIS Prro Help:o Help: Add styles to a prAdd styles to a projectoject

Lesson 6 Resources

Raster management
•• ArArcGIS PcGIS Prro Help:o Help: Mosaic daMosaic datasetstasets

Raster display
•• ArArcGIS PcGIS Prro Help:o Help: Imagery appeImagery appeararanceance
•• ArArcGIS PcGIS Prro Help:o Help: Change the symbology of imageryChange the symbology of imagery
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Lesson 7 Resources

Analysis in ArcMap and
ArcGIS Pro •• ArArcGIS PcGIS Prro Help:o Help: Schedule geoprSchedule geoprocessing toolsocessing tools
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Contact Esri Training Services

T 909 793 2853 x1585

F 909 793 5953

esri.com/training

380 New York Street

Redlands, California 92373-8100 USA
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